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Disclaimer

The information contained in this publication is subject to change without notice. VERITAS Software 
Corporation makes no warranty of any kind with regard to this manual, including, but not limited to, 
the implied warranties of merchantability and fitness for a particular purpose. VERITAS Software 
Corporation shall not be liable for errors contained herein or for incidental or consequential damages 
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Third-Party Copyrights
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Copyright (c) 1993-2002, all rights reserved.
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Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to 
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documentation.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

JacORB 1.4.1: The licensed software is covered by the GNU Library General Public License, Version 2, June 1991.

Open SSL 0.9.6: This product includes software developed by the OpenSSL Project * for use in the OpenSSL Toolkit. (http://www.openssl.org/)

TAO (ACE ORB) 1.2a: TAO(TM) is copyrighted by Douglas C. Schmidt and his research group at Washington University and University of 
California, Irvine, Copyright (c) 1993-2002, all rights reserved.



Revision History for NetBackup 5.0 iii

Revision History for NetBackup 5.0
The following table summarizes the revisions made to this document for NetBackup 
release 5.0. See the release notes for more detailed information.

Release Date Description

NetBackup 5.0 December 2003 Original version for this release.



iv NetBackup User’s Guide for UNIX



v

Contents

Revision History for NetBackup 5.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . iii

Preface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi

What Is In This Guide?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi

Getting Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xii

NetBackup Manuals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiii

Glossary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiv

Accessibility Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xv

Conventions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xv

Chapter 1. Introduction to NetBackup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

User-Directed Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Client Interfaces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Progress Logs and E-mail Notifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Backup and Archive Windows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Automatic Backups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Exclude and Include Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Redirecting Restores to Different Clients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Read This Before Using NetBackup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Cautions and Notes to Observe When Using NetBackup  . . . . . . . . . . . . . . . . . . . . . . 6

Questions to Ask Your Administrator  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

File Permissions Required By NetBackup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Chapter 2. Using the Backup, Archive, and Restore Interface  . . . . . . . . . . . . . . . . . .9



vi NetBackup User’s Guide for UNIX

Starting the Backup, Archive, and Restore Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Setting Up Your Window Manager for the Backup, Archive, and Restore Inter-
face . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Starting from a Windows Platform . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Adjusting the Time Zone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Helpful Hints on Locating and Marking Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Navigating in the Directory Trees . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

File Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Filtering Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Sorting Columns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Marking Files and Folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Unmarking Files and Folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Performing Backups and Archives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Performing Restores . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Notes on Performing Restores . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Tips on Locating Files and Folders to Restore  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Viewing the Progress of Backups and Restores  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Advanced Restore Procedures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Searching for Files to Restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Selecting Specific Backup Dates to Restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Setting the Date Range  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Restoring an Earlier Version of a Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Restoring Backup Exec Images  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Redirecting Files to a Different Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Restoring Everything to a Different Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Restoring Individual Items to Different Paths  . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Restoring a True Image of a Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Resolving Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Tips and Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Right Mouse Button Does Not Invoke Pop-up Menu  . . . . . . . . . . . . . . . . . . . . . . . . 44



Contents vii

Differentiating Between Different Backups on the Same Day . . . . . . . . . . . . . . . . . . 44

Restoring a File Not Initially Shown on the List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Unmarking a File Takes a Long Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Selecting an Invalid Policy Type Causes Problems . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Chapter 3. Using the Menu Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .47

Starting the Menu Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Performing Backups or Archives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Performing Restores  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Restoring a True Image of a Directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Redirecting Restores to Different Clients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Resolving Links  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Checking Progress of Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Chapter 4. Using the X-Windows Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .75

Starting the xbp Interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Performing Backups and Archives  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Performing Restores  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Basic Restore Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Shortcut Restore Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Listing the Available Backups or Archives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Restoring the Most Recent Backup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Restoring the Most Recent Version of a Directory  . . . . . . . . . . . . . . . . . . . . . . . . 90

Advanced Restore Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Redirecting Restores to Different Clients  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Selecting Specific Backup Dates to Restore  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Restoring an Earlier Version of a Directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Restoring a True Image of a Directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Resolving Links  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Checking Progress of Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Interpreting Progress Logs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100



viii NetBackup User’s Guide for UNIX

E-mail Notifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Deleting Progress Log Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Obtaining a List of Your Backups and Archives  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Finding and Selecting Files and Directories  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Navigating in the Directory Tree  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Show the Contents of a Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Filter by Date  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Filter by File Name  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Change the Number of Directory Levels Displayed  . . . . . . . . . . . . . . . . . . . . . . . . 102

Selecting File or Directory for Backup, Archive, or Restore . . . . . . . . . . . . . . . . . . 102

Previewing Selected Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Change Directory Structure Pane and the Files Pane Format  . . . . . . . . . . . . . . . . 103

Show Directory Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Show Number of Directory Levels Shown  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

Show Most Recent or All Backups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

Show File Details . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

Update the Display  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

Chapter 5. Reference Guide to xbp and bp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

X-Windows Interface (xbp)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Special Symbols in Menus and Dialog Boxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

xbp Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

xbp Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

Directory to Search Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Range of Dates Boxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Keyword phrase to search for Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Backup Images Pane  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

Directory Depth Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

Filename Filter Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Directory Structure Pane and the Files Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118



Contents ix

Menus (xbp)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Edit Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

View Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Backup Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

Restore Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125

Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Dialog Boxes (xbp) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

xbp_config Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

xbp_destpath Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

xbp_confirm Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

xbp_progress Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

Menu Interface (bp) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Main Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Backup Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

Backup of Files and Directories Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Archive of Files and Directories Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Database Backup Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Restore Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Restore Backups Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

Restore Archives Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

Restore Raw Partition Backups Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

Restore True Image Backups Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Restore Database Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Common Screens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147

Backup or Archive Search Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147

Restore Search Screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Search Screen Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Edit/View Selections Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150

View/Delete Selections Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151



x NetBackup User’s Guide for UNIX

Appendix A. System Administrators  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Redirecting Restores to Different Clients  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Preventing Server-Directed Restores  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157

Restoring AFS Backups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157

Browsing and Marking Volumes/Vice Partitions  . . . . . . . . . . . . . . . . . . . . . . . . . . 158

Restoring to Different Volumes/Vice Partitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . 158

Restoring Raw Partitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158

Notes on Raw Partitions and Disk Images  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159

Previewing Required Media  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163



xi

Preface

This guide describes how to use VERITAS NetBackup to perform backups, archives, and 
restores on UNIX, Linux, and Macintosh OS X systems. ( “Using the Backup, Archive, and 
Restore Interface,” “Using the Menu Interface,” and “Reference Guide to xbp and bp”do 
not apply to Macintosh OS X systems.)

This guide is intended for the system administrator and the UNIX end user. A basic 
knowledge of UNIX commands and operations is assumed.

Throughout this guide, VERITAS NetBackup is referred to as NetBackup.

What Is In This Guide?
This guide is organized as follows:

◆ Chapter 1, “Introduction to NetBackup,”  provides an overview of NetBackup, 
describes how the end user operates NetBackup, and describes technical terms and 
concepts. Read this chapter to become familiar with NetBackup.

◆ Chapter 2, “Using the Backup, Archive, and Restore Interface,” explains how to use 
the NetBackup Backup, Archive, and Restore Java interface, jbpSA, to perform 
backup, archive, and restore operations.

◆ Chapter 3, “Using the Menu Interface,”  explains how to use the NetBackup menu 
interface, bp, to perform backup, archive, and restore operations.

◆ Chapter 4, “Using the X-Windows Interface,”  explains how to use the graphical 
interface, xbp, to perform backup, archive and restore operations.

◆ Chapter 5, “Reference Guide to xbp and bp,”  describes the various windows, screens, 
and menus associated with the xbp and bp user interface programs.

◆ The Appendix “System Administrators” provides additional information on the 
jbpSA inteface for the NetBackup Administrator. 
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Getting Help
Use the VERITAS Technical support web site to get help for NetBackup if you have 
questions.

Accessing the VERITAS Technical Support Web Site

The VERITAS Technical Support Web site allows you to do any of the following:

◆ obtain updated information about NetBackup, including system requirements, 
supported platforms, and supported peripherals

◆ contact the VERITAS Technical Support staff and post questions to them

◆ get the latest patches, upgrades, and utilities

◆ view the NetBackup Frequently Asked Questions (FAQ) page

◆ search the knowledge base for answers to technical support questions

◆ receive automatic notice of product updates

◆ find out about NetBackup training

◆ read current white papers related to NetBackup

The address for the VERITAS Technical Support Web site follows:

http://support.veritas.com 

Using VERITAS Telephone and E-mail Support

Telephone support for NetBackup is only available with a valid support contract. To 
contact VERITAS for technical support, dial the appropriate phone number listed on the 
Technical Support Guide included in the product box and have your product license 
information ready for quick navigation to the proper support group.

▼ To locate the telephone support directory on the VERITAS web site

1. Open http://support.veritas.com in your web browser.

2. Click the Phone Support icon. A page that contains VERITAS support numbers from 
around the world appears.

▼ To contact support using E-mail on the VERITAS web site

1. Open http://support.veritas.com in your web browser.

2. Click the E-mail Support icon. A brief electronic form will appear and prompt you to:

http://support.veritas.com
http://support.veritas.com
http://support.veritas.com
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◆ Select a language of your preference

◆ Select a product and a platform

◆ Associate your message to an existing technical support case

◆ Provide additional contact and product information, and your message

3. Click Send Message. 

NetBackup Manuals
The following documents provided related information:

◆ VERITAS NetBackup Release Notes for UNIX and Windows

Provides important information about NetBackup on UNIX- and Windows-based 
servers, such as the platforms and operating systems that are supported and 
operating notes that may not be in the NetBackup manuals or the online help.

◆ VERITAS NetBackup Installation Guide for UNIX

Explains how to install NetBackup software on UNIX-based platforms.

◆ VERITAS NetBackup Installation Guide for Windows

Explains how to install NetBackup software on Windows-based platforms. Also 
explains how to install PC client software, which includes UNIX systems and Mac OS 
10.

If you have a UNIX server, refer to these documents:

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume I

Explains how to configure and manage NetBackup on a UNIX server, including 
managing storage units, backup policies, catalogs and host properties.

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume II

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader.

◆ VERITAS NetBackup Media Manager System Administrator’s Guide for UNIX

Explains how to configure and manage the storage devices and media on UNIX 
servers running NetBackup. Media Manager is part of NetBackup.
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◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager.

◆ VERITAS NetBackup Commands for UNIX

Describes NetBackup and Media Manager commands and processes that can be run 
from a UNIX command line.

If you have a Windows server, refer to these documents:

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume I

Explains how to configure and manage NetBackup on a Windows server, including 
managing storage units, backup policies, catalogs and host properties.

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume II

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader.

◆ VERITAS NetBackup Media Manager System Administrator’s Guide for Windows

Explains how to configure and manage the storage devices and media on Windows 
servers running NetBackup. Media Manager is part of NetBackup.

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows

Provides troubleshooting information for UNIX- and Windows-based NetBackup, 
including Media Manager.

◆ VERITAS NetBackup Commands for Windows

Describes NetBackup commands and processes that can be executed from a Windows 
command prompt.

 

Glossary
If you encounter unfamiliar terminology, consult the NetBackup online glossary. The 
glossary contains terms and definitions for NetBackup and all additional NetBackup 
options and agents.

The NetBackup online glossary is included in the NetBackup help file.
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▼ To access the NetBackup online glossary

1. In the NetBackup Administration Console (or from the Backup, Archive, and Restore 
client interface), click Help > Help Topics.

2. Click the Contents tab.

3. Double-click Glossary.

4. Click NetBackup Glossary of Terms.

The glossary displays in a help window. Use the scroll function to navigate through the 
glossary.
 

Accessibility Features
NetBackup contains features that make the user interface easier to use by people who are 
visually impaired and by people who have limited dexterity. Accessibility features 
include:

◆ Support for assistive technologies such as screen readers and voice input (Windows 
servers only)

◆ Support for keyboard (mouseless) navigation using accelerator keys and mnemonic 
keys

For more information, see the NetBackup System Administrator’s Guide, Volume I.
 

Conventions
The following section explains typographical and other conventions used in this guide.

Product-Specific Conventions

The following term is used in the NetBackup documentation to increase readability while 
maintaining technical accuracy. 

◆ Microsoft Windows, Windows

Terms used to describe a specific product or operating system developed by 
Microsoft, Inc. Some examples you may encounter in NetBackup documentation are, 
Windows servers, Windows 2000, Windows Server 2003, Windows clients, Windows 
platforms, or Windows GUI. 
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When Windows or Windows servers is used in the documentation, it refers to all of 
the currently supported Windows operating systems. When a specific Windows 
product is identified in the documentation, only that particular product is valid in that 
instance.

For a complete list of Windows operating systems and platforms that NetBackup 
supports, refer to the NetBackup Release Notes for UNIX and Windows or go to the 
VERITAS support web site at http://www.support.veritas.com. 

Typographical Conventions

Here are the typographical conventions used throughout the manuals:

You should use the appropriate conventions for your platform. For example, when 
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX. 
Significant differences between the platforms are noted in the text.

Tips, notes, and cautions are used to emphasize information. The following samples 
describe when each is used.

Tip Used for nice-to-know information, like a shortcut.

Conventions 

Convention Description

GUI Font Used to depict graphical user interface (GUI) objects, such as fields, 
listboxes, menu commands, and so on. For example: Enter your 
password in the Password field.

Italics Used for placeholder text, book titles, new terms, or emphasis. Replace 
placeholder text with your specific text. For example: Replace filename 
with the name of your file. Do not use file names that contain spaces.

This font is also used to highlight NetBackup server-specific or operating 
system-specific differences. For example: This step is only applicable for 
NetBackup Enterprise Server.

Code Used to show what commands you need to type, to identify pathnames 
where files are located, and to distinguish system or application text that 
is displayed to you or that is part of a code example.

Key+Key Used to show that you must hold down the first key while pressing the 
second key. For example: Ctrl+S means hold down the Ctrl key while 
you press S.
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Note Used for important information that you should know, but that shouldn’t cause any 
damage to your data or your system if you choose to ignore it.

Caution Used for information that will prevent a problem. Ignore a caution at your own 
risk.

Command Usage

The following conventions are frequently used in the synopsis of command usage.

brackets [ ]

The enclosed command line component is optional.

Vertical bar or pipe (|)

Separates optional arguments from which the user can choose. For example, when a 
command has the following format:

command arg1|arg2

In this example, the user can use either the arg1 or arg2 variable.

Navigating Multiple Menu Levels

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a 
continued action.

The following example shows how the > is used to condense a series of menu selections 
into one step:

❖ Select Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console.

The corresponding actions could be described in more steps as follows:

1. Click Start in the task bar.

2. Move your cursor to Programs.

3. Move your cursor to the right and highlight VERITAS NetBackup.

4. Move your cursor to the right. First highlight and then click NetBackup 
Administration Console.
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Introduction to NetBackup 1
NetBackup lets you back up, archive, and restore files, directories, or raw partitions that 
reside on your client system. In NetBackup terminology, the system that needs the backup 
or restore is the client. The system that manages the storage and retrieval of the backup 
data is called the NetBackup server.
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User-Directed Operations
User-directed operations are NetBackup operations that the user can perform from the 
client. These operations can be performed without administrator intervention or logging 
into the NetBackup server.

User-directed operations include:

◆ Back up files, directories or raw partitions that reside on your local disk. A backup 
operation saves the data to a storage device on the NetBackup server.

◆ Archive files and directories that reside on your local disk. An archive operation saves 
the selected files and directories to a storage device on the NetBackup server and then 
deletes them from your local disk.

◆ Restore previously backed up or archived files, directories, or raw partitions to either 
the location from which they were backed up or to another location. You select what 
you want to restore and NetBackup automatically restores it to the disk.

After you start a user-directed operation, the server manages storage and retrieval of data. 
All file transfers occur in the background so there is no long wait for the operation to 
complete before regaining control of your terminal.

Client Interfaces
NetBackup provides four client interfaces:

◆ Backup, Archive, and Restore interface (for Java)

◆ Menu interface

◆ X-Windows graphical interface

◆ Command line interface

You can perform user-directed operations through any of these interfaces, but the Backup, 
Archive, and Restore and menu interfaces are the one that you will probably use most 
often:

◆ The Backup, Archive, and Restore interface can be used on NetBackup-Java capable 
platforms. The jbpSA command starts Backup, Archive, and Restore. Refer to “Using 
the Backup, Archive, and Restore Interface” on page 9 for information on using this 
interface.

◆ The menu interface is used on virtually any terminal that can connect to a client 
system. The bp command starts the menu interface program. Refer to “Using the 
Menu Interface” on page 47 for details on using the bp menu interface. 
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◆ The X-Windows interface is used on any X terminal or workstation with an X server 
program compatible with X11.R4 or later. The xbp command starts this interface. 
Refer to “Using the X-Windows Interface” on page 75 for details on using the xbp 
graphical interface.

◆ The command line interface lets you perform backup, archive, restore, and list 
operations by entering individual commands at the shell prompt. 

The following commands are available in the command line interface:

bparchive

bpbackup

bplist

bprestore

For descriptions of commands, see the man pages. To view the man pages, enter, for 
example: 

man bpbackup

Note If the man pages are not installed on your system, contact your system 
administrator. 

Information on the commands is also included in the NetBackup System Administrator’s 
Guide for UNIX, Volume I.

The Backup, Archive, and Restore, X-Windows, and menu interfaces have all the options 
necessary to perform and monitor user-directed operations. An important feature of these 
interfaces is their built-in ability to browse for and select files and directories:

◆ During a backup or archive, you can browse the file system on your client to select 
files and directories.

◆ During a restore, you can browse the backup history for your client to select files and 
directories that you have previously saved. It is also possible to browse the backup 
history for other clients if the NetBackup administrator gives you the necessary 
permissions.
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Progress Logs and E-mail Notifications
NetBackup progress logs provide information on the progress of a NetBackup operation. 
These logs also indicate the success and failure of a NetBackup operation. For each 
user-directed operation, NetBackup can be configured to create a separate progress log 
file. You can delete the log files when they are no longer needed. For more details on 
creating log files, refer to “Checking Progress of Operations” on page 98 for xbp or 
“Checking Progress of Operations” on page 74 for bp. For more details on log files, refer 
to “Viewing the Progress of Backups and Restores” on page 30.

The NetBackup server can be configured to deliver e-mail notifications to the client user 
on the status of the client user’s NetBackup operations. Refer to the NetBackup System 
Administrator’s Guide, Volume I for details on configuring the server for e-mail 
notifications.

Backup and Archive Windows
NetBackup can be configured to allow user-directed backups or archives to occur only 
during specific time periods, usually referred to as windows. For example, if your window 
is from 8 am to 6 pm, you will not be able to back up or archive at other times. The 
NetBackup administrator defines these windows during server configuration. For more 
information, refer to the NetBackup System Administrator’s Guide, Volume I.

Note The backup and archive windows do not affect user-directed restores. You can 
perform a restore at any time.

Automatic Backups
The NetBackup administrator can configure NetBackup to perform automatic full and 
incremental backups of your client system. These backups occur unattended and under 
control of the NetBackup server. If carefully scheduled, the automatic backups will meet 
most of the backup requirements for your client. NetBackup can also be configured to 
send e-mail on the success or failure of automatic backups to the administrator of your 
client system.

For more information on automatic backups and other administrator directed activities, 
refer to the NetBackup System Administrator’s Guide, Volume I.
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Exclude and Include Lists
The NetBackup system administrator configures the exclude and include lists for your 
client. 

The NetBackup exclude list contains a list of files and directories that will not be included 
in scheduled backups. Files and directories in the exclude list can still be backed up 
manually through the user interface.

In some cases, the system administrator may create an exclude list for a specific policy or 
for a policy and schedule combination. The master server will use a single exclude list 
when performing a scheduled backup for all clients in the specified policy or policy and 
schedule combination. If, however, an individual client finds that a file or directory must 
be included in a scheduled backup, then an include file list can be created on the client.

The NetBackup include list contains a list of files and directories that will be included in a 
scheduled backup. This is also useful if, for example, you want to exclude an entire 
directory except for one file.

The NetBackup System Administrator’s Guide, Volume I provides instructions for creating the 
exclude and include lists.

Redirecting Restores to Different Clients
With the necessary permissions and configuration, users can browse the NetBackup 
database for files backed up by another NetBackup client and restore files to their own 
computer.

System administrators can direct restores to the client that originally backed up the files or 
to a different client. This type of restore can be performed on any server and is called a 
server-directed restore. The NetBackup administrator can direct file or raw partition 
restores to any client. For more information refer to “Redirecting Restores to Different 
Clients” on page 153.

Read This Before Using NetBackup
Read the following before performing any user operations with NetBackup. 
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Cautions and Notes to Observe When Using NetBackup
◆ When performing backups and archives, remember that if a file is only a symbolic link 

to another file, NetBackup backs up or archives only the link, not the file itself. This 
eliminates multiple backups of a file when more than one directory contains a 
symbolic link to it. It also means you must be certain to back up or archive the source 
file.

◆ On a Hewlett Packard system, do not attempt to restore a file in a CDF directory if the 
CDF does not already exist. If you do, the directory is created without the directory 
mode bits necessary for it to be recognized as a CDF. The correct procedure is to 
restore the CDF itself thus restoring the files it contains. To restore only missing files 
in a CDF, ensure that you specify to not overwrite existing files. 

◆ The maximum path length that you can specify for a file is 1023 characters.

◆ The overwrite option is ignored during raw partition restores. The device file must 
exist and the disk partition is overwritten whether or not this option is set. 

Questions to Ask Your Administrator
During configuration, the administrator configures NetBackup to meet the backup and 
archiving requirements of your site. The following are some questions you should ask the 
administrator about your configuration before you use NetBackup. Knowing the answers 
to these questions can help you to avoid problems later.

Which files and directories will NetBackup include in automatic backups of your client?

The list that the administrator configures may not include everything on your local disk. If 
there are additional files that you want backed up, you can either ask the administrator to 
add them to the file list for automatic backups or back them up yourself.

When do the automatic backups occur?

By knowing the schedules, you can recognize when you must perform your own backups 
to preserve critical data.

When are user-directed backups and archives permitted for your client? 

During configuration, the administrator determines when you can perform backup and 
archive operations. For example, if they are allowed between 8 am and 4 pm, you will be 
unable to perform a backup or archive at 6 pm.

What is the retention period for your data? 

It is difficult to recover expired backups. Therefore, ensure that the retention time is long 
enough to suit your needs.
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(NetBackup DataCenter users) Can you back up, archive, and restore NFS mounted 
files? 

NetBackup allows this but your specific configuration may not. Remember that when you 
archive NFS files, you remove them from the system on which they reside.

Does your configuration permit backups and archives of entire file paths even if they 
cross file systems? 

For example, if the backups and archives for your workstation are configured to cross file 
systems, specifying / (root) backs up the entire disk. Otherwise, specifying / backs up 
only the files and directories that are in the / file system and excludes files in other file 
systems.

How do you restore files that were backed up or archived by another client?

Normally, NetBackup allows you to restore files only for the original client. The 
administrator can override this if necessary.

Is the NetBackup configuration set up to provide you with e-mail notifications on the 
results of your user-directed operations?

These e-mail notifications can eliminate the need for you to monitor the progress logs. 
NetBackup can also send e-mail on the success or failure of automatic backups to the 
administrator of your client system.

File Permissions Required By NetBackup
You need UNIX read permission to back up a file and UNIX write permission to archive a 
file (since the archive operation removes the file from the disk).

Note During a backup or archive, NetBackup stores only the user ID and group ID that 
are assigned to the files. NetBackup does not store the user ID and group ID of the 
person performing the backup. For example, assume a user uuu and group ggg own 
a file and the root user backs it up. Regardless of who restores it, the restored file 
still shows user ID = uuu and group ID = ggg.

Listing and restoring files and directories require the following UNIX permissions:

◆ To list or restore files in a directory owned by someone else, you must have read and 
execute permission for the directory and all directories leading to it. 

◆ To restore a file to its original location, you must have write access to the file (if the file 
exists), or to the directory (if the file does not exist).
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The following table shows how NetBackup restores files in various situations (for 
example, if a copy of the file or directory already exists).

File Permissions

Type of Restore Attempted Results

Restore a file that already 
exists and overwrite the 
existing file.

If you are a root user, NetBackup restores the file and sets file 
ownership to the same owner as the backup image.

If you are not a root user, NetBackup restores the file only if you 
have write access to it. In a case where the file is read only, but you 
have write access to the parent directory, NetBackup removes the 
file and restores the backup image with you as the owner.

Restore a file that already 
exists and not overwrite the 
existing file.

For both root and nonroot users, NetBackup does not restore the 
file and places a message in the progress log.

Restore a file that does not 
exist.

If you are a root user, NetBackup restores the file and sets file 
ownership to the same owner as the backup.

If you are a nonroot user, the file is created with you as the owner 
and restored only if permissions on the parent directory allow it.

Restore a file when a directory 
exists with the same name as 
the file.

For both root and nonroot users, NetBackup places an error 
message in the progress log and does not restore the file or remove 
the directory. This occurs regardless of whether or not you elect to 
overwrite existing files.

Restore a directory when a file 
exists with the same name as 
the directory.

NetBackup restores the directory and removes the file, providing 
that permissions allow it and you elect to overwrite existing files. 
Ownerships are set as follows:

If you are a root user, NetBackup sets ownership of the directory to 
that of the original owner. 

If you are a nonroot user, the user name under which you are doing 
the restore is assigned ownership.

Restore a file in a directory 
that does not exist.

NetBackup creates the directory with the user name and the name 
of the user group doing the restore and uses the mask bits 022 to set 
the mode of the directory. The file is then restored in the same 
manner as one that does not exist (see above).
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Using the Backup, Archive, and Restore 
Interface 2

The Backup, Archive, and Restore interface (jbpSA) provides a graphical user interface 
through which users can perform backups, archives, and restores. The interface can be 
started and run on all NetBackup-Java capable platforms.

Topics covered in this chapter include:

◆ Starting the Backup, Archive, and Restore Interface

◆ Adjusting the Time Zone

◆ Helpful Hints on Locating and Marking Files

◆ Performing Backups and Archives

◆ Performing Restores

◆ Viewing the Progress of Backups and Restores

◆ Advanced Restore Procedures

◆ Tips and Troubleshooting
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Starting the Backup, Archive, and Restore Interface
         

You can use Backup, Archive, and Restore to log in to any NetBackup client and then 
perform backups, archives, and restores on that client.

▼ To start Backup, Archive, and Restore

1. Log in to the NetBackup computer where you are going to start Backup, Archive, and 
Restore. 

2. Start Backup, Archive, and Restore by executing:

/usr/openv/netbackup/bin/jbpSA &

For additional usage information enter: jbpSA -h.

3. In the Login dialog box, type the name of the client where you want to perform the 
backup, archive, or restore.

You must have a valid user account on that client and have access to that client. 

4. Specify the user name.

5. Specify the password.

6. Click Login.

NetBackup Client

NetBackup UNIX Client

bear

tiger

shark

Backup, Archive, and 
Restore interface NetBackup UNIX Client
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Setting Up Your Window Manager for the Backup, Archive, and 
Restore Interface

Always set your window manager so windows become active only when you click inside 
the windows. Do not enable auto focus, which is when windows become active if you just 
move the mouse pointer over them. The NetBackup-Java interface does not run properly 
with auto focus enabled. The following are general instructions for correctly setting up the 
focus.

CDE (Common Desktop Environment)

The following explains how to set up a CDE (Common Desktop Environment) window 
manager, which is the preferred window manager for NetBackup-Java applications.

▼ To configure CDE for Backup, Archive, and Restore

1. On the front panel in the CDE window, click the Style Manager control icon.

The Style Manager toolbar appears.

2. On the Style Manager toolbar, click the Window control icon.

The Style Manager - Window dialog box appears.

3. In the Style Manager - Window dialog box, click the Click In Window To Make 
Active button.

4. Click OK.

5. Click OK when asked to Restart the Workspace Manager.

Motif

When using the Motif window manager, set the Mwm*keyboardFocusPolicy X 
resource as follows:

Mwm*keyboardFocusPolicy:explicit

Starting from a Windows Platform
You can also use the Backup, Archive, and Restore interface from a Windows platform, if 
you have installed the Windows Display Console. The WDC can only be used to log into a 
UNIX client.
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▼ To start the Windows Display Console

1. On the Windows Start menu, click Programs > VERITAS NetBackup > NetBackup - 
Java on host.

The Login dialog box appears. host is the default NetBackup client where you 
perform user operations. 

To log into and perform user operations on another client, type its name in the Host 
name field. 

2. Type your user name and password and click Login.

3. When login is complete, the Backup, Archive, and Restore interface appears.
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Adjusting the Time Zone
If you have NetBackup servers and clients in different time zones, you may have to adjust 
the time zone when restoring files. Set the time zone relative to the server’s time zone. 
NetBackup gives you the ability to adjust the time zone settings for the current session 
(and for all future sessions, if you have administrative capabilities). 

There are two situations where it would be necessary to change the time zone settings:

◆ You reside in a time zone that is not correctly translated by the underlying Java code 
in NetBackup. The Middle European time zone, for example, is interpreted as Middle 
Eastern Time. You will need to adjust the time zone settings so that backups receive 
the correct datetime stamps.

◆ You administer sites that are in different time zones. You may need to adjust the time 
zone settings before restoring files.

For example, you received a request to restore a backup made on March 3, 2000 at 12:00 
a.m. United States Eastern Standard Time (EST), which is 5 hours behind Greenwich Mean 
Time (GMT), and you reside in the Pacific Standard time zone (PST), which is 8 hours 
behind GMT. If you do not change your time zone settings to EST and search for backups 
created on March 3, 2000, you will not be able to find the backup. According to your PST 
time zone settings (PST), the backup was created at 9:00 p.m. on March 2, 2000.
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▼ To adjust the time zone settings

1. On the File menu, click Adjust Application Timezone.

The Adjust Timezone dialog box appears. You can use either the Standard or Custom 
tab to configure the time zone.

2. To use the Standard tab to configure the time zone, do the following:

a. Clear the Use custom time zone check box.

b. Select the time zone.

c. To use daylight savings time, select Use daylight savings time.

d. To have administrative capabilities and apply the settings to the current session 
and all future sessions, select Save as default timezone.

3. To use the Custom tab to configure the time zone, do the following:

a. Select the Use custom time zone check box.

b. Select the time zone on which to base the Backup, Archive, and Restore interface 
time.

c. Adjust the time to reflect how many hours/minutes the server’s time zone is 
offset (either behind or ahead) of Greenwich Mean Time. 

d. To use daylight savings time, select Use daylight savings time.

e. Indicate when Daylight Savings Time (DST) should begin. You can use one of the 
following methods:

◆ To begin DST on a specific date, select Absolute date and indicate the desired 
month and day.

◆ To begin DST on the first occurrence of a day in a month, select First day of 
week in month and indicate the desired day of the week and the month.

◆ To begin DST on the first occurrence of a day in a month and after a specific 
date, select First day of week in month after date and indicate the desired 
day of the week and the month and day.

◆ To begin DST on the last occurrence of a day in a month, select Last day of 
week in month and indicate the desired day of the week and the month.
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◆ To begin DST on the last occurrence of a day in a month and before a specific 
date, select Last day of week in month after date and indicate the desired 
day of the week and the month and day.

f. Select the appropriate Day of week, Month, Day, and Time.

g. Indicate when DST should end, using one of the methods defined in step e.

h. To have administrative capabilities and apply the settings to the current session 
and all future sessions, select Save as default timezone.

4. Click OK.

To have DST begin on: Enter this:

April 5

the first Monday in April

the first Monday after April 1

the last Thursday in April

the last Thursday before April 30
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Helpful Hints on Locating and Marking Files
This section explains what you need to know to navigate in the directory trees and filter 
files on the Backup Files and Restore Files tabs and how to mark files and folders for 
backup or restore operations. 

Navigating in the Directory Trees
To display the contents of a folder:

◆ Click on the folder name in the left pane. The right pane will show the contents of that 
folder.

◆ Folders that have subfolders have a plus sign (+) to the left of the folder. To display 
the subfolders, click on the plus sign or double-click on the folder. The left pane will 
display the subfolders within that folder. 

◆ On the Restore Files tab, you can also display the contents of a folder by typing the 
directory path in the Browse directory box and pressing Enter.

◆ To collapse a folder, click on the minus sign (-) to the left of the folder or double-click 
on the folder.

File Icons
The following icons are used to indicate the file types displayed in the Contents of 
Selected Directory pane.

Description Icon

Represents a directory.

Represents a Java file.

Represents a Java class file.

Represents a program file.

Represents an HTML file.

Represents a UNIX link.

Represents a read-only file.
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Filtering Files
You can filter the files and folders shown in the Contents of Selected Directory pane. To 
display only filenames beginning with “sys,” for example, type sys* in the Filename 
filter field, then on the View menu click Refresh. To display only files with the “txt” 
extension, type in *.txt. This filter is case-insensitive.

When starting the Backup, Archive, and Restore interface, * appears in the Filename filter 
box. This will display all files.

Sorting Columns
The columns in the right pane can be sorted by clicking on the column header. To sort by 
Modified date, for example, click on the Modified column header. Click on the column 
header again to sort in descending order.

Marking Files and Folders
◆ To mark a file for backup or restore, select the checkbox to left of a file or right-click on 

the file and select Mark Selected Files.

◆ To select multiple contiguous files, click on the first file you wish to mark, hold down 
the Shift key, and click on the last file in the group you wish to mark. To select 
non-contiguous files, hold down the Ctrl key as you make your selections.

Right-click and select Mark Selected Files to mark the files you selected.

◆ To mark a folder for backup or restore, select the checkbox to the left of a folder. A 
check mark will appear in the box. A slash mark in the box indicates only some of the 
files or subfolders within that folder are marked.

Marking a folder automatically marks all its files and subfolders.

◆ To mark all files displayed in the right pane, from the Edit menu, choose Mark 
Displayed Files. 

Represents a text file.

Represents a bitmap, gif, or icon file.

Represents a file that doesn’t have an icon associated with it.

Description Icon
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If more than one version of a file is displayed (because the file was backed up more 
than once during the date range selected), NetBackup will mark only the most recent 
version.

Unmarking Files and Folders
◆ To unmark a file, clear the checkbox to the left of the file, or right-click on the file and 

select Unmark Selected Files.

◆ To unmark a folder, and all the files and subfolders marked within that folder, clear 
the checkbox to the left of the folder.

◆ To unmark all backup or restore selections, choose Unmark Displayed Files from the 
Edit menu.
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Performing Backups and Archives
This section will step you through a simple backup procedure. The process would be the 
same if you choose to archive, except that the files you choose will be deleted after they 
are backed up.

This process assumes that you have already started the Backup, Archive, and Restore 
interface as described in “Starting the Backup, Archive, and Restore Interface” on page 10.

▼ To perform a backup

1. Click the Backup Files tab.

2. If necessary, change the NetBackup master server that will perform the backup.

If there is more than one master server to which you can send your backups and 
archives, ensure that you are connected to the correct one. Ask your NetBackup 
administrator if you have questions about which master server to use. 
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Normally, you will not have to switch master servers unless, for some reason, the 
administrator has temporarily moved the NetBackup backups (for example, because 
of a problem on the original master server). If the change becomes permanent, the 
administrator should change your default to reflect the other server.

a. On the Actions menu, click Specify NetBackup Machines and Policy Types.

b. Click on the NetBackup server tab.

c. Select the desired server from the list.

If you indicate an invalid name, or if your client does not belong to a NetBackup 
policy on that server, you will get an error when the backup begins. If this occurs, 
see your system administrator for assistance.

d. Click OK.

3. Select the file or files to back up. In this example the selected file is sample.txt.
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You can filter the files and folders shown in the Contents of Selected Directory pane. 
Once you have entered the filter criteria, click Refresh from the View menu. For more 
information, see “Filtering Files” on page 17.

4. Click Backup to start the Backup operation.

The Backup Files dialog box is displayed.

5. To delete the file after it has been backed up, select Archive files.

6. To remove a file from the list of files to back up, select the file and click Remove from 
list.

7. To associate a keyword phrase with the backup or archive, type a keyword or phrase 
into the Keyword phrase to associate with this backup or archive box. You can then 
search for that keyword or phrase if you wish to restore this specific backup or 
archive.

In this example, the keyword phrase test backup was used.

8. To write the backup progress messages to a log file other than the default, deselect 
Use default progress log filename and then enter the name of the alternative 
progress log in the Progress log filename field. Applies to UNIX systems only.
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9. Click Start Backup to begin the backup operation.

Note The NetBackup operation may take a few minutes to complete. 

You will be prompted to view the status of the backup operation.

10. Click Yes to open the Task Progress tab.

The Task Progress tab allows you to view the progress report of a NetBackup 
operation. For more information, see “Viewing the Progress of Backups and Restores” 
on page 30.
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Performing Restores
This section will step you through a simple restore process, using the same file that was 
backed up in the previous section. It assumes that Backup, Archive, and Restore has 
already been started as described in “Starting the Backup, Archive, and Restore Interface” 
on page 10.

Notes on Performing Restores
◆ Before performing a restore, ensure that the correct or desired time zone settings have 

been set. See “Adjusting the Time Zone” on page 13.

◆ If there are any links in the path you are searching, NetBackup, by default, resolves 
the links so the path points to the actual file or directory. If you do not want to resolve 
links, deselect Use Actual Path If Browse Directory is Linked on the Actions menu 
before starting your search. See “Resolving Links” on page 42 for more information.

◆ NetBackup restores files according to the original file pathname. If the files you are 
restoring already exist, you must have the proper file permissions in order to 
overwrite the existing files with the files that were backed up. See “File Permissions 
Required By NetBackup” on page 7 for an explanation of how NetBackup restores 
files in various situations.

Tips on Locating Files and Folders to Restore
You can narrow your search by indicating the following information. When finished, 
update the right pane by clicking Refresh on the View menu.

◆ If you know the exact directory you wish to browse, type the path to that directory in 
the Browse directory box.

◆ You can filter the files and folders shown in the Contents of Selected Directory pane. 
Once you have entered the filter criteria, select View > Refresh. For more information, 
see “Filtering Files” on page 17.

◆ If you indicated a keyword phrase when you performed a backup, you can use that 
keyword or phrase to locate that backup by specifying that keyword phrase (select 
Actions > Set Keyword).
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▼ To perform a restore

1. Click the Restore Files tab.

Note When the Restore Files tab is displayed intially, nothing is shown in either pane.

2. Change the NetBackup master server if necessary.

If there is more than one master server that can back up this client, ensure that you are 
connected to the one that performed the backup you are trying to restore. If you 
attempt to restore from another master server, the files will not be found. Ask your 
NetBackup administrator if you have questions about which master server to use.

a. On the Actions menu, click Specify NetBackup Machines and Policy Types.

b. Click on the NetBackup server tab.

c. Select the desired server from the list.

d. Click Make Current.
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e. Click OK.

If you indicate an invalid name or if your client does not belong to a NetBackup 
policy on that server, you will get an error when attempting to browse for files to 
restore. If this occurs, see your system administrator for assistance.

3. Select the type of restore to perform. Select Actions > Select Restore Type or select an 
option from the Restore Type list box.

◆ To restore a backup, click Normal Backup.

◆ To restore an archive, click Archived Backups.

◆ To restore from a raw partition backup, click Raw Partition Backups. See 
“Restoring Raw Partitions” on page 158 for more information.

◆ To restore a true image backup, click True Image Backups. For more information 
on restoring a true image backup, see “Restoring a True Image of a Directory” on 
page 40.

◆ To restore a Backup Exec backup, click Backup Exec Backups. For more 
information on restoring a Backup Exec backup, see “Restoring Backup Exec 
Images” on page 35.

◆ To restore to a point in time, select Point in Time Rollback. Point in Time 
Rollback is available only with the Advanced Client option; for more information, 
see the NetBackup Advanced Client System Administrator’s Guide.

4. Select the folder or file to restore. 

You can filter the files and folders shown in the Contents of Selected Directory pane. 
Once you have entered the filter criteria, click Refresh on the View menu. For more 
information, see “Filtering Files” on page 17.

In this example, we will use the keyword phrase feature to restore the sample.txt 
that was backed up in “Performing Backups and Archives” on page 19.

a. From the Actions menu, click Set Keyword.

b. Type test backup in the New keyword phrase box and click OK.
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c. In the right pane, select the checkbox to the left of the sample.txt file.

5. Click Restore.
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The Restore Files dialog box is displayed.

By default, files will be restored to their original location. See “Redirecting Files to a 
Different Path” on page 36 for information on restoring all files to a different 
destination or restoring individual files to multiple destinations.

6. Select Overwrite existing files. By default, NetBackup does not overwrite files.

7. Select Restore directories without crossing mount points to skip over file systems 
mounted in the selected directories. Clear this checkbox to restore file systems that are 
mounted in the selected directories.

Note Mount points inside will get restored whether or not the Restore directories 
without crossing mount points checkbox is selected.
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8. If you are a system administrator and are redirecting Microsoft Windows files to a 
Microsoft Windows system, select whether to include the Windows access-control 
attributes.

9. If supported, the Restore Files dialog will include an active Restore without 
access-control attributes (Windows clients only) option. By default, both data and 
ACLs are restored. To restore files without restoring the access-control attributes, 
select Restore without access-control attributes.

10. If you are restoring files that are links, choose whether to update those link 
pathnames.

◆ Select Rename hard links to rename the hard link pathnames. Clear the Rename 
hard links checkbox if you do not want to rename the hard link pathname.

◆ Select Rename soft links to rename the soft (symbolic) link pathnames. Clear the 
Rename soft links checkbox if you do not want to rename the soft link pathname.

Note If you are restoring system files to a disk other than the current system disk and 
plan on using the other disk as the system disk with the original file paths when the 
restore is completed, we suggest that you select the Rename hard links checkbox 
and clear the Rename soft links checkbox. This will let you use the other disk and 
have the correct file paths.

11. Click Start Restore to begin the restore operation.

You will be prompted to view the status of the restore operation.

12. Click Yes to open the Task Progress tab.
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The Task Progress tab allows you to view the progress of a NetBackup operation. For 
more information, see “Viewing the Progress of Backups and Restores” on page 30 .
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Viewing the Progress of Backups and Restores

▼ To view the progress of a backup or restore

1. Click the Task Progress tab.

2. Click Update Task List to refresh the list of tasks being performed.

3. Click on the task for which you want to check the progress.

The lower pane will reflect the progress of the item selected in the top pane.

4. To automatically refresh the results of the tasks, select Auto Refresh and select a 
refresh interval. 

The default setting is 10 seconds. A smaller interval may negatively affect server 
performance. 

5. By default the progress file is displayed in an abbreviated form. If you wish to view 
the entire contents of the progress file, click Full Contents.

The NetBackup operation is finished when the Status changes to Successful. If the task 
fails, review the results of task log and check with your NetBackup system administrator.
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Advanced Restore Procedures
The following procedures provide detailed explanations for performing advanced 
restores.

Searching for Files to Restore
Occasionally, you might want to restore a file or directory, but you may not remember 
where it is, or was, located. The Find feature allows you to specify a file or directory name 
and search for it.

▼ To find a directory or file

1. In Backup, Archive, and Restore, click on the Restore Files tab.

2. On the Actions menu, click Search Backups. 

The Search Backups dialog box appears.

3. In the File or directory name box, type the name of the directory or file you wish to 
search for.

You can use the wildcard symbol (*) to search for a directory or file if you are unsure 
of the exact name or wish to display directories or files with similar names.

4. If you want to perform a case-insensitive search, select the Perform case insensitive 
search option. The default is case-sensitive, meaning the file name must match exactly 
as it was entered. 

For example, if you type sample.txt and select case-sensitive, NetBackup will only 
find files that use that exact capitalization. The files Sample.txt and SAMPLE.TXT 
would not appear in the results.

5. Click Search. 

NetBackup will display all backups of the directory or file you entered.
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Note It may take a few minutes for the list of files to refresh. 

6. To select a file or folder, click on the checkbox to the left of the file or folder.

7. Click OK to return to the Restore Files tab in the Backup, Archive, and Restore 
interface. 

The files or folders you selected are now marked to be restored.

8. To start the restore operation, click Restore.

Selecting Specific Backup Dates to Restore
By default, the NetBackup Restore window shows the files and folders that were backed 
up since the last full backup. The default range will satisfy the majority of your needs to 
restore files but there will be times when you must restore a file that was not backed up 
during the default time period. For example, a file that was deleted prior to the last full 
backup will not appear in the default display. To locate and back up this file, you would 
need to change the date range.

If the client belongs to more than one policy, the starting date defaults to the last full 
backup that occurred first. For example, assume that: (1) a client belongs to PolicyW1 and 
PolicyW2, (2) Full backups occur for both of these policies, (3) PolicyW1’s most recent full 
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backup occurred on June 16 and PolicyW2’s most recent full backup occurred on June 24. 
NetBackup will display those files and folders that have been backed up since the 
PolicyW1 full backup on June 16.

Note The Contents of Selected Directory pane will show only the files and subdirectories 
that were backed up during the range of dates indicated. If a file or directory was 
backed up more than once during the date range selected, multiple copies of that 
file or folder will appear in the right pane.

Setting the Date Range

There are two ways you can set the date range: by selecting the dates using the Calendar, 
or by selecting the dates using the Backup History.

▼ To set the date via the Calendar

1. Select Actions > Set Date Range > Calendar.

The Date Range dialog box displays.

2. Click the Start Date tab.

3. Select the desired start date on the calendar.

◆ To change the month, select the desired month from the drop-down list in the 
upper left-hand corner of the dialog.

◆ To change the year, select the desired year from the drop-down list in the upper 
left-hand corner of the dialog.

◆ To change the time, select the part of the time you wish to change. Use the spinner 
controls to indicate an earlier or later time.

4. Click the End Date tab and choose the desired end date.

5. Click OK.

▼ To set the date via the Backup History

1. On the Actions menu, point to Set Date Range, and click Backup History.

The Date Range dialog box appears.
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2. Select the desired backup image or images from the list, shown as follows:

Tip To select multiple contiguous backup images, select the first backup image, press 
the Shift key, and click the last image in the group you wish to select. 

3. Click OK.

Restoring an Earlier Version of a Directory
The following procedure will restore all files that were backed up during the range of 
backup dates that you searched for files to restore. This includes files that were deleted 
from your online directory after they were backed up. If you do not want the deleted files, 
use the procedure described in “Restoring a True Image of a Directory” on page 40.

▼ To restore an earlier version of a directory

1. Click the Restore Files tab.

2. Select the desired Restore Type.

3. Use the Calendar or Backup History list to select the date range that contains the 
version of the directory you wish to restore.
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4. From the Directory Structure pane, select the directory you wish to restore. Check the 
right pane to see if it shows the files you need.

Note By default, NetBackup restores the directory to its original location. To restore to a 
different location, see “Redirecting Files to a Different Path” on page 36.

5. Click Restore.

The Restore Files dialog box is displayed.

6. Click Start Restore to begin the restore operation.

Restoring Backup Exec Images
NetBackup can read and restore Backup Exec images written by Backup Exec 7.0 or later, 
but the Backup Exec images must first be imported into NetBackup by your system 
administrator. 

Backup Exec backup type descriptions in the NetBackup Restore window differ from the 
descriptions of the NetBackup types. The differences are as follows:

Microsoft SQL Server images cannot be restored using the UNIX Backup, Archive, and 
Restore interface. For information about restoring Microsoft Exchange images created by 
Backup Exec, see the NetBackup for Microsoft Exchange Server System Administrator's Guide. 

▼ To restore from Backup Exec images

1. Start the Backup, Archive, and Restore interface.

2. Click on the Restore Files tab.

3. Select Backup Exec Backups.

NetBackup Backup Type Backup Exec Backup Type

Full Full, Copy

Differential Incremental

Cumulative Incremental Differential

User Backup All Other Types
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4. Select the files or folders to restore. 

5. Click Restore.

The Restore Files dialog box appears.

6. Select the desired restore options.

By default, files will be restored to their original location. See “Redirecting Files to a 
Different Path” on page 36 for information on restoring all files to a different 
destination or restoring individual files to multiple destinations.

7. Click Start Restore to start the restore operation.

Redirecting Files to a Different Path
In some instances, you may want to restore items to a file or path other than the one from 
which they were backed up. All items can be restored to a different path or individual 
items can be restored to different paths.

The redirection format for Backup Exec images is the same as the redirection format for 
NetBackup images. NetBackup does not support restoring Backup Exec Netware 
non-SMS backups created using the Netware redirector.

Restoring Everything to a Different Path

▼ To restore everything to a different location

1. Click on the Restore Files tab.

2. On the Actions menu, point to Select Restore Type and choose the desired type of 
restore, or select the restore type from the Restore Type list box.

3. Select the files or folders you wish to restore.

Note You will be able to restore files and folders differently depending on how you mark 
the files and folders for a restore. If you wish to restore an entire folder and all its 
contents to the same location, mark the folder in the left pane. If you wish to restore 
the files in a folder to different locations, mark the files in the right pane.

4. Click Restore. 

The Restore Files dialog box is displayed.
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5. Select Restore everything to a different location.

6. In the Destination box, enter the directory to which you want to restore the files or 
folders.

7. Select any other desired restore options. For information on these options, refer to 
“Performing Restores” on page 23.

8. Click Start Restore.
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Restoring Individual Items to Different Paths

▼ To restore files and directories to different locations

1. Click on the Restore Files tab.

2. On the Actions menu, point to Select Restore Type and choose the desired type of 
restore, or select a restore type from the Restore Type list box.

3. Select the files or folders you wish to restore.

Note You will be able to restore files and folders differently depending on how you mark 
the files and folders for a restore. If you wish to restore an entire folder and all its 
contents to the same location, mark the folder in the left pane. If you wish to restore 
the files in a folder to different locations, mark the files in the right pane.

4. Click Restore.
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5. Select Restore individual directories and files to different locations.

6. Select the file or directory which you want to restore to a different location.

You can select multiple files and folders using Ctrl + click or Shift + click (see 
“Marking Files and Folders” on page 17).

7. Click Change Selected Destinations.

8. In the Destination field, enter the destination for the file or files.

9. Click OK.

10. Select any other desired restore options. For information on these options, refer to 
“Performing Restores” on page 23.

11. Select Overwrite existing files.
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12. To begin the restore operation, click Start Restore.

Restoring a True Image of a Directory
A true image restore of a directory, by default, restores the directory so its contents are 
exactly what they were at the time of the most recent automatic full or incremental 
backup. Files deleted prior to the specified backup are not restored. 

A true image restore is the best choice if, for example, you have recently cleaned up a 
directory by deleting unwanted files and now want to restore the latest version without 
having to repeat your cleanup. It is also possible to restore the true image of an earlier 
version of a directory.

Example of a True Image Restore

To illustrate the concept of a true image restore, consider the following table, which shows 
the contents of a directory named home/abc/doc during a series of backups performed 
between 12/01/00 and 12/04/00.

Assume that you are going to restore the most recent version of the directory.

◆ If you perform a standard restore, NetBackup will restore all files and subdirectories 
that were backed up during the time period from 12/01/00 (last full backup) through 
12/04/00. 

file1
file2
dirA/fileA
dirB/fileB
file3
dirC/fileC
file4

file1

file2

dirA/fileA

dirB/fileB

file3

file1

file2

dirA/fileA

-

-

file1 file1 file1

file2 file2 file2

dirA/fileA dirA/fileA

-

-

-

-

-

-

dirC/fileC

file4 file4

-

-

Day
Type of Backup

12/01/00
(Full)

12/02/00
(Incr)

12/03/00
(Incr)

12/04/00
(User Back)

12/04/00
(Incr)
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◆ If you restore a true image backup, NetBackup restores only the files and directories 
that existed at the time of the incremental backup on 12/04/00. 

file1
file2
file4

NetBackup does not restore anything deleted prior to the 12/04/00 incremental 
backup. 

Notice that the restored directory does not include the dirA and dirC subdirectories, 
even though they were backed up on 12/04/00 with a user-directed backup. 
NetBackup did not restore these directories because they did not exist at the time of 
the incremental backup that was the reference for the true image restore.

True Image Restore and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that 
are currently in the directory but not in the true image restore backups. 

Using the previous example, if you had created a file5 after the incremental backup 
occurred on 12/04/00, but before doing the restore, then the contents of the directory after 
the restore would have been:

file1
file2
file4
file5 (this is the new file that is not in any of the backups)

▼ To restore a true image of a directory

Note You can restore a true image of a folder only if the NetBackup Policy that is backing 
up your files is configured to collect true image restore information prior to backup. 
If in doubt, ask your NetBackup administrator.

Note NetBackup does not allow a true image restore that is based on the time of a 
user-directed operation. However, NetBackup does use the data from a 
user-directed operation when performing a true image restore if the user backup is 
more recent than the latest automatic full or incremental backup.

1. Click on the Restore Files tab.

2. Make sure that your root directory is selected.

3. Select Actions > Select Restore Type > True Image Backups. 
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4. To refresh the list of backups available for restore, click View > Refresh .

5. Select the directory that you want to restore.

Since you are restoring a directory in its entirety, as it existed on a specific date, 
NetBackup only allows you to select one version of the directory. For the same reason, 
the Mark Displayed Files button is also disabled.

Note If NetBackup does not find any directories, check the range of dates and path. If 
these settings are correct and no directories are found, check with your 
administrator to see if the NetBackup Policy that is backing up your files and 
directories is configured to collect true image restore information.

6. Click Restore. 

The Restore Files dialog box is displayed. 

7. To begin the restore operation, click Start Restore.

By default, the folder is restored to its original location.

Resolving Links
When searching for files to restore, you can choose whether to have NetBackup resolve 
links that may exist in the search path. If you resolve links, NetBackup automatically 
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the 
path you type in. jbpSA resolves links by default, unless you deselect Use Actual Path If 
Browse Directory is Linked (on the Actions menu) before starting your search.

Note NetBackup does not resolve links if you use wildcard characters in the search 
directory path.

It is usually best to resolve links. There are exceptions, such as the following:

◆ If you backed up a file that was not a link and, since then, the file path was linked to a 
different directory. 
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For example, assume you backed up /home/bjm and this directory is now a link to 
/home2/bjm . If you resolve links during the restore, NetBackup will not find the file 
because it will search for /home2/bjm and /home/bjm was the path you backed up.

◆ If you are restoring a file to your machine that was backed up by another client. There 
will be a problem if the path exists as a link on your machine, but not on the other 
client.

For example, assume that the path /usr/openv/ is linked to /opt/openv on the 
local machine, but not on the other client machine. If you deselect Use Actual Path If 
Browse Directory is Linked, jbpSA will look for /opt/openv on the other client, 
even though the path doesn’t exist on that client.

1. Directory is backed up.

2. File path is linked to a different directory.

3. User attempts to restore the directory.

If links are resolved:

NetBackup resolves the directory to /home2/bjm 
and cannot find it in the backup image.

If links are not resolved:

NetBackup does not resolve the directory and is 
able to restore it.

/home/bjm

/home/bjm /home2/bjm

/home/bjm

Backup Image

/home/bjm /home2/bjm
Directory not 

restored

/home/bjm Directory 
restored
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Tips and Troubleshooting
The following sections provide information on some common issues.

Right Mouse Button Does Not Invoke Pop-up Menu
On a Solaris x86 with a two-button mouse, right-clicking will not invoke the pop-up 
menu.

▼ To invoke the pop-up menu

1. Press and hold the right mouse button.

2. Press the Ctrl key.

3. Release the right mouse button.

4. Release the Ctrl key.

Differentiating Between Different Backups on the Same Day
By default the Restore Files tab only shows the latest file entries since the last full backup. 
This is designed to reduce the number of files displayed. 

Sometimes it is useful to see all the available backups, perhaps to restore the version from 
three days ago. In this instance, use the Calendar or Backup History list to select the 
appropriate date (see “Selecting Specific Backup Dates to Restore” on page 32). 

If a file or folder was backed up more than once during the date range selected, multiple 
entries will be shown for that file or folder. You can narrow the list by entering a smaller 
date range or by changing the time.

Restoring a File Not Initially Shown on the List
If a file is not initially shown in the list of files that can be restored, it is likely that the file 
was backed up by the user, and not in the last full backup. Use the Backup History list to 
select user backups for specific dates or use the Calendar to specify a new start date, then 
click Refresh on the View menu.
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Unmarking a File Takes a Long Time
Sometimes when you unmark a file it may take a long time before control of the 
application is returned to you. This can happen when you have marked an entire 
directory (in the Directory Structure pane) and then you unmark a single file in the 
directory.

Selecting an Invalid Policy Type Causes Problems
Although it is possible to change the policy type, in most situations the default policy type 
is appropriate and should not be changed. 

Symptoms of an invalid policy type are: 

◆ All attempts to back up files fail. The following error message appears in the Task 
Progress tab for each failed backup: 

no active policies in the configuration database are of the 
correct policy type.

◆ Existing backups do not appear in the Directory Structure and Contents of Selected 
Directory panes. 

If you suspect a problem is caused by an invalid policy type setting, change the Policy 
type to the value appropriate for your operating environment (“Standard” for UNIX). If 
problems persist, ask your NetBackup administrator for advice on setting this to match 
your organization’s NetBackup configuration. 
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Using the Menu Interface 3
This chapter explains how to use the NetBackup menu interface program, bp, to perform 
NetBackup operations. The menu interface is character-based so you can use it at any 
terminal (or terminal emulation window) for which you have a termcap or terminfo 
definition. You can also use the X-Windows interface (xbp) or the Backup, Archive, and 
Restore interface (jbpSA) on any terminal with the proper prerequisites. The menu 
interface has the functionality of xbp and jbpSA but with a menu-driven presentation.

The purpose of this chapter is to provide step-by-step procedures for using the menu 
interface. If you need information about specific screens or menu options within the 
interface, refer to Chapter 5, “Reference Guide to xbp and bp” on page 105.

The areas covered here are:

◆ Starting the Menu Interface

◆ Performing Backups or Archives

◆ Performing Restores

◆ Checking Progress of Operations
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Starting the Menu Interface
Start the menu interface program by typing the /usr/openv/netbackup/bin/bp 
command.

When bp starts, the Main Menu appears on your screen as shown. 
 

The name of your client and NetBackup master server are shown at the top of the menu. If 
more than one master server is available to your client, you can use the m (Change Master 
Server) option on the Backup Menu to select another server.

Performing Backups or Archives
The following procedure explains how to perform a backup of files, directories, or raw 
partitions or to archive files and directories. The main difference between backups and 
archives is that an archive deletes the designated directories and files from your disk after 
successfully backing them up.

▼ To perform a backup

1. Type the following command line: 

/usr/openv/netbackup/bin/bp
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The Main Menu displays.
 

2. Select the b (Backup) option. The Backup Menu displays.
 

Refer to “Backup Menu” on page 134 for details on this menu.

Check the name in the Master Server field. This field shows the name of the server to 
which NetBackup will send your backups. When you start the bp interface program, 
the default master server is your client.
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You should not have to switch master servers unless the administrator has moved the 
backups. If the change becomes permanent, the administrator should change your 
default to reflect the other master server.

To change master servers, choose the m (Change Master Server) option and type the 
name of the other server. If you type an invalid name or your client does not belong to 
a policy on that server, you will get an error.

3. Select the b (Backup Files and Directories) option. The Backup of Files and Directories 
menu will appear.

4. Check the Search Path field at the top of the menu to see if it is set to the directory 
where you want to start the search for the desired files. At start-up, NetBackup sets 
Search Path to your current working directory.

In this example, we are going to backup the release_notes.txt file located in the 
/usr/openv/netbackup/ directory. 

a. To change the path, choose the p (Change Search Path) option from the Backup of 
Files and Directories menu. The following prompt displays.

b. Type the following for the New File Path.
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/usr/openv/netbackup/ 

c. Press Enter to return to the Backup of Files and Directories menu.

5. Check that the Start Date and End Date fields include the last-modified dates of the 
files you want to back up.

a. To change the range of dates, select the d (Change Date Range) option from the 
Backup of Files and Directories menu. The following prompt displays.

b. Type the New Start Date.

c. Press Enter. The following prompt displays.

d. Type the New End Date.

e. Press Enter to return to the Backup of Files and Directories menu.

6. Type the keyword phrase you want to use to identify the backup. In this example, we 
will use the keyword bptest.
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a. Select the k (Change Keyword Phrase) option from the Backup of Files and 
Directories menu. The following prompt displays.

b. Type the keyword bptest.

c. Press Enter to return to the Backup of Files and Directories menu.

7. Select the files and directories you want to back up.

a. Select the s (Select Files and Directories) option from the Backup of Files and 
Directories menu. The following prompt displays.

b. Use the menu options at the bottom of the screen to browse the file system and 
select the desired files and directories.
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c. Choose the (S)elect option to select the release_notes.txt file. An asterisk (*) 
displays to the left of the selected file.

If you select a directory, all files and directories below the selected directory will 
be selected. An asterisk (*) will appear to the left of the selected directory.

d. Select the (O)k option to return to the Backup of Files and Directories menu. 

8. Preview the files and directories you have selected to back up.
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a. Select the e (Edit/View Selected Files) option from the Backup of Files and 
Directories menu. A list of the selected files displays.

This screen lists your selections and lets you make changes. 

b. Make sure the release_notes.txt file appears in the list. 

c. Select the (O)k option to return to the Backup of Files and Directories menu.

9. Start the backup operation.

Note You can return to the Backup of Files and Directories menu at any time up to 
starting the operation by pressing the Escape key.

a. Select the i (Initiate Backup) option from the Backup of Files and Directories 
menu. The following prompt displays.
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b. Type y to create a log file and write to this file as the operation progresses. The 
following prompt displays.

If you do not want logging, type n to start the operation and go to step d. 

c. Press Enter to accept the default (shown in parentheses), or type a new path and 
press Enter. The operation begins when you press Enter. The following prompt 
displays.

d. Press any key to return to the Backup of Files and Directories menu.

10. Select the Q (Quit Menu) option to return to the Main Menu.
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Performing Restores
NetBackup restores files according to the original file pathname. If current files have the 
same names as backed-up files, you can specify whether or not to overwrite the current 
files (file permissions must allow overwriting). See “File Permissions Required By 
NetBackup” on page 7 for an explanation of how NetBackup restores files in various 
situations.

Note When restoring NetWare backups, set the directory depth to a minimum of 6 to 
ensure that the backup image is displayed.

Note When restoring raw partitions, ensure that the partition is not mounted and not in 
use. Also ensure that the device file for the raw partition exists prior to the restore.

▼ To perform a restore

1. Type the following command line: 

/usr/openv/netbackup/bin/bp

The Main Menu displays.
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2. Choose the r (Restore) option from the Main Menu. The Restore Menu displays.
 

Refer to “Restore Menu” on page 140 for details on this menu.

Note The f (Restore From Auspex FastBack Backups) option is not supported in 
NetBackup 5.0. Auspex is no longer a valid client type.

If your site supports more than one master server and you want to browse or restore 
files from another server, check the Master Server field at the top of the screen. When 
you start the bp interface program, the Master Server field shows the default for your 
client.

To browse a backup on another master server, choose the m (Change Master Server) 
option and type the name of the other server. If you type an invalid name or your 
client does not belong to a policy on that server, you will get an error.
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3. Select the b (Restore Files and Directories From Backups) option. The Restore Backups 
menu will appear.

4. View the backups for your client.

a. Choose the l (List Backup Images) option from the Restore Backups menu.

This screen shows the backups created. Notice that the keyword bptest, entered 
during the backup procedure described in “Performing Backups or Archives” on 
page 48, is displayed under the keyword column. For this example, we will be 
restoring from the backup with the bptest keyword.

b. Select (Q)uit to return to the Restore Backups menu.
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5. Check the Policy Type field to see if it is set correctly.

a. To change the policy type, select the y (Change Policy Type) option from the 
Restore Backups menu. 

 

The current policy type appears in parentheses.

Note Auspex FastBack s not supported in NetBackup 5.0. Auspex is no longer a valid 
client or policy type.

b. Type the number for the new policy type.

c. Press Enter to return to the Restore Backups menu.

6. Check the Search Path field at the top of the Restore Backups menu to see if it is set to 
the directory in which you want to start the search. At start up, the current path is set 
to the directory from which you start the interface program. 

a. To change the path, select the p (Change Search Path) option. The following 
prompt displays.
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For this example, we will be changing the path to /usr/openv/netbackup.

b. Type the new file path.

/usr/openv/netbackup

The search begins in this directory and goes down the directory tree.

c. Press Enter to return to the Restore Backups menu.

7. Check the Start Date and End Date fields to see if the range of dates includes the 
backup dates of the files you want to restore.

a. To change the range of dates, select the d (Change Date Range) option from the 
Restore Backups menu. The following prompt displays.

b. Type the New Start Date.

c. Press Enter. The following prompt displays.

d.  Type the New End Date.

e. Press Enter to return to the Restore Backups menu.

8. Select the files and directories you want to restore.
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a. Select the s (Select Files and Directories) option from the Restore Backups menu 
to search for files and directories that belong to the client and meet the path and 
date criteria. The list of files and directories displays.

If you are restoring an entire directory and the range of dates includes more than 
one backup date for files in the directory, NetBackup restores only the most recent 
backups. To restore earlier versions, you can either:

◆ Restore by file rather than by directory and select the files with the desired 
backup date. 

or 

◆ Return to step 7 and specify only the backup dates you desire. 

Here, you can restore the entire directory. Before proceeding, however, decide 
whether you want to overwrite all files in that directory with the earlier 
versions. If you do not want to overwrite existing files, you can restore the 
directory to a different path (see step 10 of this procedure).

You may also want to refer to “Shortcut Restore Procedures” on page 89 and 
“Restoring a True Image of a Directory” on page 69.

b. Use the menu options at the bottom of this screen to move the display arrow to 
the line with the release_notes.txt file. 
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c. Select the (S)elect to select the release_notes.txt file. An asterisk (*) displays 
to the left of the selected file.

If you had selected a directory, all directories and files below the selected 
directory would have been implicitly selected. An asterisk (*) displays to the left 
of the selected directory.

d. Select the (O)k option to return to the Restore Backups menu.

9. Preview the files and directories you have selected to restore.
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a. Select the e (Edit/View Selected Files) option from the Restore Backups menu. 
The list of selected files displays.

This screen lists your selections and lets you make changes.

b. Make sure the release_notes.txt file appears in the list. 

c. Select the (O)k option to return to the Restore Backups menu.

10. Set up a redirected restore to a different path. 

This is an optional step, used to restore files to a different path on the same client. In 
the following example, we will set up a redirected restore from 
/usr/openv/netbackup to /usr/openv/netbackup/bin.

Note You cannot use NetBackup on the master server to redirect restores of a file to a 
different path on a NetBackup Novell NetWare client. For those clients, you must 
perform the redirected restore with the user interface on the NetWare client.
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a. Choose the a (Change Destination Path) option from the Restore Backups menu. 
The following prompt displays.

b. Press Enter. The following prompt displays.

c. Type the following path in the Enter Restore To field.

/usr/openv/netbackup/bin

d. Press Enter. The following prompt displays.
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e. Type y to use the indicated Enter Restore From and Enter Restore To paths on the 
next restore. The following prompt displays.

Type n to cancel the changes so the previous paths are still used.

f. Press any key to return to the Restore Backups menu.

11. Start the restore operation.

a. Select the i (Initiate Restore) option from the Restore Backups menu. The 
following prompt displays.

Caution The overwrite option is ignored during raw partition restores. The device file 
must exist and the disk partition is overwritten whether this option is set or not.
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b. Type y to overwrite existing files. The following prompt displays.

Type n to if you do not want to overwrite existing files.

c. Type y to create a log file and write to this file as the operation progresses. The 
following prompt prompt displays.

If you do not want logging, type n to start the operation and go to step d. 

d. Press Enter to accept the default (shown in parentheses), or type a new path and 
press Enter. The operation begins when you press Enter.
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If you have previously changed the destination path (see step 10) the Use 
destination path substitution? prompt displays:

Type n to start the restore operation and ignore the destination path entered.

e. Type y to use the destination path entered. 

f. Press Enter. The following prompt displays.

Note If you are restoring system files to a disk other than the current system disk, and 
plan on using the other disk as the system disk with the original file paths when the 
restore is completed, we suggest that you specify y (yes) when prompted to rename 
hard links and n (no) when prompted to rename soft links. This will allow you use 
the other disk and have the correct file paths.

If there are links in the path you are searching, NetBackup prompts you to specify 
whether you want to resolve the links so the path points to the actual file or 
directory. If you do not want to resolve links, answer n (no) to the prompt. See 
“Resolving Links” on page 73 for more information.
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g. Type n. The following prompt displays.

h. Type n. The restore operation begins. The following prompt displays.

i. Press any key to return to the Restore Backups menu.
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Restoring a True Image of a Directory
A true image restore will restore the contents of a directory to what it was at the time of a 
selected automatic full or incremental backup. See “Restoring a True Image of a 
Directory” on page 40 for an overview of true image recovery. The concepts explained 
there for the Backup, Archive, and Restore interface also apply to the menu interface.

▼ To restore a true image of a directory

1. Select the d (Restore From True Image Backups) option from the Restore Menu. The 
Restore True Image Backups menu appears.

2. Select the d (Change Date Range) option from the Restore True Image Backups menu. 

◆ The default Start Date is the time of the last scheduled full backup of the policy. 
Use the default unless you are restoring a version that existed before the latest full 
backup.

◆ The default End Date is the current date. If necessary, change this value to the 
reflect the date that you want to recover.

In this example, we are recovering the most recent version of the directory so the 
default date range is not changed.

3. To view the backup list for true image restore backups, choose the l (List TIR Backup 
Images) option from the Restore True Image Backups menu.

4. To change the path, Select the p (Change Search Path) option from the Restore True 
Image Backups menu. 
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Type the directory which contains the desired backups. Searching begins in this 
directory and goes down the directory tree.

To search for a specific directory, type its complete path at the prompt. 

5. Select the s (Select Files and Directories) option from the Restore True Image Backups 
menu to search for directories that belong to the client and meet the path and date 
criteria. 

Individual files do not appear and cannot be selected because true image restores are 
intended only for restoring entire directories. To list or select individual files in a true 
image restore backup or range of backups, use the Restore Backups menu. 

A true image restore will restore files that existed in the directory at the time of the 
incremental backup. Files that did not exist at the time of the incremental backup will 
not be restored.

Note If NetBackup cannot find any directories, check your range of dates, path, and 
directory depth. If these settings are correct and no directories are found, check with 
the administrator on the master server to see if the NetBackup policy that is backing 
up your files and directories is configured to collect true image restore information.

6. Select the files or directories you want to restore.

a. Use the menu options at the bottom of the screen to find and select the desired 
directory. 

b. When you are through selecting, select the (O)k option to return to the Restore 
True Image Backups menu. 

7. Preview the files and directories you selected to restore.

a. Select the e (View/Delete Selected Files) option from the Restore True Image 
Backups menu. 

b. Check that the directories you selected appear in the list.

c. Select the (O)k option to return to the Restore True Image Backups menu.

8. If you want to restore to a directory other than the one from which the files were 
originally backed up, choose a (Change Destination Path) option from the Restore 
True Image Backups menu.

9. Select the i (Initiate Restore) option to display the Initiate Restore screen.

10. Answer the prompts to start the restore. 
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If you are overwriting the directory you are restoring, NetBackup does not delete files 
that are currently in the directory but not in the true image restore backups. See “True 
Image Restore and Overwriting” on page 41.

Redirecting Restores to Different Clients

Note You cannot use NetBackup on the master server to redirect restores of a file to a 
different path on a NetBackup Novell NetWare client. For those clients, you must 
perform the redirected restore with the user interface on the NetWare client.

▼ To redirect a restore to a different client

1. Choose the r (Restore) option from the Main Menu. The Restore Menu displays.

2. Select the b (Restore Files and Directories From Backups) option. The Restore Backups 
menu displays.

3. Change the source client.

a. Select the b (Change Source Client) option from the Restore Backups menu. The 
following prompt displays.

The current client appears in parenthesis.

b. Type the client name from which you want to browse and restore files.

c. Press Enter to return to the Restore Backups menu.

4. Change the destination client.
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a. Select the t (Change Destination Client) option from the Restore Backups menu. 
The following prompt displays.

The current client appears in parenthesis.

b. Type the client name to which you want to restore files.

Note The destination client must be of the same policy type as the source client.

c. Press Enter to return to the Restore Backups menu.

5. Check the policy type for the source client and the destination client.

a. To change the policy type, select the y (Change Policy Type) option from the 
Restore Backups menu. The current policy type appears in parenthesis.

b. Type the policy type for the source client and the destination client.

c. Press Enter to return to the Restore Backups menu.

6. Check the Search Path field at the top of the Restore Backups menu to see if it is set to 
the directory at which you want to start the search for the desired backups. 

a. To change the path, select the p (Change Search Path) option. 

b. Type the new file path.

c. Press Enter to return to the Restore Backups menu.

7. Select the files and directories you want to restore.

a. Select the s (Select Files and Directories) option from the Restore Backups menu 
to search for files and directories that belong to the source client and meet the 
path and date criteria. 

b. Use the menu options at the bottom of this screen to move the display arrow to 
the files or directories you want to restore to the destination client.



Chapter 3, Using the Menu Interface

Performing Restores

73

c. Select the (S)elect option to select the file or directory. An asterisk (*) will appear 
to the left of the selected file or directory.

If you select a directory, all directories and files below the selected directory will 
be implicitly selected. 

d. Select the (O)k option to return to the Restore Backups menu.

8. Preview the files and directories you have selected to restore.

a. Select the e (Edit/View Selected Files) option from the Restore Backups menu. 
The resulting screen lists your selections and lets you make changes.

b. Review your selections. 

c. Select the (O)k option option to return to the Restore Backups menu.

9. Select the i (Initiate Restore) option to start the restore operation.

10. Follow the prompts. The restore operation begins when you press Enter.

Resolving Links
When searching for files to restore, you can choose whether to have NetBackup resolve 
links that may exist in the search path. If you resolve links, NetBackup automatically 
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the 
path you type in. For more information, see “Resolving Links” on page 42.

Note If links exist in the selected path, you get a prompt at the time you elect to browse 
the backups.

Note NetBackup does not resolve links if you use wildcard characters in the search 
directory path.
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Checking Progress of Operations
When you start a NetBackup operation, you can have NetBackup create a log file in a 
directory of your choice and write to this file during the course of the operation. By 
default, NetBackup creates a log file in your home directory of the form:

bplog.bkup.n (for backups)

bplog.arch.n (for archives)

bplog.rest.n (for restores)

Where n is a number that is unique for each file.

You can read log files by using the more command or a UNIX file editor. Delete the logs 
when you no longer need them. 

Note Before deleting the log files, be sure to verify that they do not contain warnings or 
error messages.

See “Interpreting Progress Logs” on page 100 for information on interpreting the logs.



75

Using the X-Windows Interface 4
This chapter explains how to use the xbp interface to perform NetBackup operations. This 
interface is X-Windows based and requires an X terminal or a workstation with an X 
server program compatible with release X11.R4 or later. The interface uses OSF and Motif 
conventions.

The purpose of this chapter is to provide step-by-step procedures for using the xbp 
interface. For information about specific windows or menu options within this interface, 
refer to Chapter 5, “Reference Guide to xbp and bp” on page 105. Refer also to the online 
help facility.

The areas covered here are as follows:

◆ Starting the xbp Interface 

◆ Performing Backups and Archives

◆ Performing Restores

◆ Checking Progress of Operations

◆ Obtaining a List of Your Backups and Archives

◆ Finding and Selecting Files and Directories
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Starting the xbp Interface

▼ To start the xbp interface

1. Ensure that your X terminal or workstation X server is named according to X 
conventions.

2. Set your DISPLAY environment variable to the appropriate value. 

The most convenient method is to define the DISPLAY variable with your login 
procedure.

The following example uses the setenv command after login to set up the display for 
an X terminal or server named orca:

setenv DISPLAY orca.user.abc.com:0

You can also use the -d option when you execute the xbp command (see step 3). 

3. Start the xbp interface by typing the xbp command as shown in the following 
examples. The variation you use depends upon whether your DISPLAY environment 
variable is already set:

◆ If the DISPLAY variable is set, type:

/usr/openv/netbackup/bin/xbp &

◆ If the DISPLAY variable is not set, use the -d option:

  /usr/openv/netbackup/bin/xbp -d orca.user.abc.com:0 &

The & character puts the program in background mode so your original window stays 
active and is available for other activities.
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When xbp starts, the xbp window displays on your screen. 

When you start xbp, the Browse file system (backup or archive) command from the File 
menu is selected by default. The Directory Structure pane and the Files pane show all 
directories and files in the directory specified in the Directory to Search box down to the 
level specified in the Directory Depth box. The Directory to Search box is set to the 
directory where you start xbp. You set the number of levels down in the Directory Depth 
box. 

Refer to “xbp Window” on page 108 for details on this window.
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Performing Backups and Archives
The following procedure explains how to perform a backup of files, directories, or raw 
partitions or to archive files and directories. The main difference between backups and 
archives is that an archive deletes the designated files and directories from your disk after 
successfully backing them up.

▼ To perform a backup operation

1. Change NetBackup master servers if necessary.

If there is more than one master server to which you can send your backups and 
archives, ensure that you are connected to the correct one. Ask your NetBackup 
administrator if you have questions about which master server to use.

Normally, you will not have to switch master servers unless, for some reason, the 
administrator has temporarily moved the NetBackup backups (for example, because 
of a problem on the original master server). If the change becomes permanent, the 
administrator should change your default to reflect the other server.

a. Click Configuration on the File menu.

The the xbp_config dialog box displays.

The name of the current master server appears in the Server box. When you start 
xbp, the server is set to the default for your client. 

If you do not want to change the master server, click Cancel. If you want to 
change the master server, go to the next step.

b. Type the name of the other server in the Server box.

c. Click OK.
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If you typed an invalid name, or if your client does not belong to a NetBackup 
policy on that server, you get will an error. If this occurs, see your system 
administrator for assistance.

2. Find and select the desired files and directories.

If the desired files or directories are not currently displayed, find them by using the 
methods described under “Finding and Selecting Files and Directories” on page 101.

In this example we are going to select the release_notes.txt file.

a. Select the /usr/openv/netbackup directory in the Directory Structure pane.

When a directory is selected in the Directory Structure pane, all of the 
subdirectories and files listed in the Files pane are implicitly selected. These 
implicitly selected subdirectories and files will not appear highlighted in the Files 
pane.

b. Select release_notes.txt in the Files pane.
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3. On the Backup menu, click Backup selected files and directories. 

This opens the xbp_confirm dialog box. 
 

Note If you click Archive selected files and directories, NetBackup will back up the 
selected directory and all of its subdirectories, then delete the backed up directories 
from your system.

a. Review your selections in the xbp_confirm dialog box.

b. Choose whether to use the progress log file.

Select the Use log file checkbox to create a log file in your home directory and 
write to this file as the operation progresses.

The name of the log file appears in the Log Filename box. For information on 
checking the log, see “Checking Progress of Operations” on page 98.

c. Type a keyword in the Keyword phrase to associate with this backup box.
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The phrase you type in the Keyword phrase to associate with this backup box 
will be the key for finding this backup during the restore process. In this example 
we will use the keyword test. You will use this keyword during the restore 
operation in the following section.

d. Click OK. This sends your backup request to the server. The main window will 
appear.

To return to the main window without starting the backup or archive, click 
Cancel.
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Performing Restores
The following topics explain how to restore files, directories, and raw partitions:

◆ Basic Restore Procedure - includes detailed instructions for restoring files.

◆ Shortcut Restore Procedures - abbreviated procedures for common operations.

◆ Advanced Restore Operations - information on performing true image restores and 
redirecting a restore to a different client.

Basic Restore Procedure
The following procedure is a detailed explanation of how to restore files, directories, and 
raw partitions to your client system.

Note When restoring Novell NetWare backups, set the directory depth to a minimum of 6 
to ensure that the backup image is displayed.

Note If you are restoring raw partitions, ensure that the partition is not mounted and not 
in use. Also ensure that the device file for the raw partition exists prior to the 
restore.

Note If you are restoring a directory, you may want to refer to “Shortcut Restore 
Procedures” on page 89 and “Restoring a True Image of a Directory” on page 95.

▼ To perform a basic restore

1. Change NetBackup master servers if necessary. 

If there is more than one master server that can back up this client, ensure that you are 
connected to the one that performed the backup you are trying to restore. If you 
attempt to restore from another master server, the files will not be found. Ask your 
NetBackup administrator if you have questions about which master server to use.
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a. On the File menu, click Configuration. Refer to “File Menu” on page 120 for 
details on this menu.

This opens the xbp_config dialog box.

The name of the current master server appears in the Server box. When you start 
xbp, the server is set to the default for your client. 

If you do not want to change the master server, click Cancel. If you want to 
change the master server, go to the next step.

b. Type the name of the other server in the Server box.

c. Click OK.

If you typed an invalid name, or if your client does not belong to a NetBackup 
policy on that server, you get will an error. If this occurs, see your system 
administrator for assistance.

2. Find the file and/or directory to restore.
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a. On the File menu, click Browse backups (restore).

A main window similar to the following will appear. 

Note If there are a large number of backups in your range of dates, a message box may 
display, indicating that you cannot search for a specific path until you update the 
display. If this message appears, select Update Display from the Edit menu.

b. Specify the directory to search.

In this example, we are going to restore the release_notes.txt file backed up 
in “Performing Backups and Archives” on page 78. Type the following in the 
Directory to Search box:

/usr/openv/netbackup/
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Note If there are any links in the path you are searching, NetBackup, by default, resolves 
the links so the path points to the actual file or directory. If you do not want to 
resolve links, click Do Not Resolve Links in Search Directory on the View menu 
before choosing a browse command from the File menu. See “Resolving Links” on 
page 98 for more information.

c. Specify the range of dates.

When you go from backup mode to restore mode, NetBackup normally changes 
the starting date so that it defaults to the time of the last full backup. If you type in 
a specific date before changing modes, your specification is used. See “Selecting 
Specific Backup Dates to Restore” on page 93 for more details.

d. Specify the keyword phrase to search for.

In step c on page 80 of the “Performing Backups and Archives” section, test was 
entered as the keyword. So, in the Keyword phrase to search for box, type test.

e. Type *.txt in the Filename Filter box.

f. On the File menu, click Browse backups (restore).
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A main window similar to the following will appear. 

g. Select the files and directories that you want to restore.

If the desired files or directories are not currently displayed, find them by using 
the methods described under “Finding and Selecting Files and Directories” on 
page 101. You can also specify another range of backups to search. (See “Selecting 
Specific Backup Dates to Restore” on page 93.)
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In the following figure, the /usr/openv/netbackup directory is selected in the 
Directory Structure pane. This implicitly selects all directories and files that are 
below /usr/openv/netbackup in the directory tree.

Note If you are selecting directories on the Files pane and then change your mind and 
deselect a directory, it is not deselected until you have selected either Clear 
selections for current directory or Discard selections for previous directories from 
the Edit menu. If you use Inspect all selections from the Edit menu, you can see 
what is selected to be restored.

3. Start the restore.
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a. Click Restore search directory from the Restore menu. 

This opens the xbp_confirm dialog box.
 

b. Choose whether to use the progress log file.

Select the Use log file checkbox to create a log file in your home directory and 
write to this file as the operation progresses. 

The name of the log file appears in the Log Filename box. For information on 
checking the log, see “Checking Progress of Operations” on page 98.

c. Select the Overwrite existing files checkbox. 

Note The disk partition is overwritten whether this option is set or not. The device file 
must exist. 

The Redirected restore checkbox and the Restore directories without crossing 
mount points checkbox are enabled.

Note Mount points inside will get restored whether or not the Restore directories 
without crossing mount points checkbox is selected.

NetBackup restores files according to the original file’s pathname. 

◆ Select the Overwrite existing files checkbox to overwrite an existing file with 
the restored file, providing file permissions allow it. (See “File Permissions 
Required By NetBackup” on page 7.)
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◆ Clear the Overwrite existing files checkbox to prevent overwriting. The 
restore does not occur if a file with same pathname already exists.

d. Review your selections.

4. Click OK. This will send your restore request to the server. The main window will 
appear.

To return to the main window without starting the restore, click Cancel.

Shortcut Restore Procedures
The following are abbreviated procedures for common types of restore operations.

Listing the Available Backups or Archives

If you are not sure of the dates when a file or directory was backed up, you can find out by 
browsing the backups. 

▼ To browse the available backups

1. Type the directory that you want to restore in the Directory to Search box.

2. Leave the range of dates at the defaults (01/01/70 to the current date).

or

If you know the approximate range, type it in to narrow the range that will be 
displayed. Doing this speeds up your request.

3. On the File menu, choose the desired browse for restore option.

NetBackup updates the Directory Structure pane and the Files pane to show all 
backups or archives for the specified directory path and date range.

Because NetBackup has to obtain the file information from the backups on the master 
server, there can be a noticeable delay before the panes appear in the restore window.

Note If there are a large number of backups in the date range, you may be prompted to 
use Update Display from the Edit menu before NetBackup will search for the 
specific path.
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Restoring the Most Recent Backup

The following explains how to restore the most recent backup that has occurred since the 
last full backup of your client.

▼ To restore the most recent backup

1. Type the directory that you want to restore in the Directory to Search box.

2. On the File menu, click Browse backups (restore).

NetBackup updates the Directory Structure pane and the Files pane to show only the 
files and directories that were backed up from the time of the last full backup through 
the most recent backup (either incremental or user-directed).

Since NetBackup has to obtain the file information from the backups on the master 
server, there can be a noticeable delay before the panes appear in the restore window.

Note By default, NetBackup restores the file to its original location. To restore to a 
different path, use Specify Destination Path from the Restore menu before starting 
the restore.

3. Select the most recent backup of the file you want to restore.

Note If you are selecting directories on the Files pane and then change your mind and 
deselect a directory, it is not deselected until you have selected either Clear 
selections for current directory or Discard selections for previous directories from 
the Edit menu. If you use Inspect all selections from the Edit menu, you can see 
what is selected to be restored.

4. On the Restore menu, click Restore selected files and directories.

This starts the restore.

Restoring the Most Recent Version of a Directory

Note The following procedure will restore all files that existed in the directory from the 
time of the last full backup through the most recent backup. Files that were deleted 
from your online directory during that time period are also restored. If you do not 
want the files that were deleted from your online directory, proceed to “Restoring a 
True Image of a Directory” on page 95.
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You can restore the latest version of a directory with just one restore operation. The steps 
are the same as explained under “Restoring the Most Recent Backup” on page 90, except 
that here you must select a directory from the Directory Structure pane and use Restore 
search directory from the Restore menu. The restored directory has the last full backup of 
that directory, updated with all subsequent incremental and user backups.

There are two important things to remember when restoring a directory:

◆ The restored directory has only the files that are in the range of backups you selected 
with the start and end dates. Therefore, these dates must include the last full backup 
and all other backups through the latest date you are interested in. The best way to get 
the most recent backup is to use the date of the last full backup as start date and the 
current date as the end date (this is the default at the start of a browse).

◆ It is usually best to select from the Directory Structure pane. Selecting from the Files 
pane restores only from the backup created at the backup date and time. If that 
backup is for an incremental, you will restore only the files in that incremental.

Advanced Restore Operations
The topics in this section explain how to perform more specialized restore operations. 
Also see the section on server-directed restores in the NetBackup User’s Guide for UNIX or 
the NetBackup User’s Guide for Windows.

Redirecting Restores to Different Clients

The following explains how to redirect a restore to a different client. Refer to “Basic 
Restore Procedure” on page 82 for a detailed restore procedure.

Note You cannot use NetBackup on the master server to restore a file to an alternate path 
on a NetBackup for Novell NetWare client. For those clients, you must perform the 
alternate path restore with the user interface on the NetWare client.

▼ To redirect restores

1. Change NetBackup master servers if necessary. 

a. From the File menu, click Configuration. 

This opens the xbp_config dialog box.

b. Type the name of the server in the Server box.

c. Click OK.
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If you type an invalid name or your client does not belong to a NetBackup policy 
on that server, you will get an error. See your system administrator for assistance.

2. From the Restore menu, click Specify Destination Path.

This opens the xbp_destpath dialog box. 

a. Type the paths in the Restore From box and the Restore To box.

You can also use the Current Directory button to change paths to their default 
value, which is your current directory. 

You cannot specify more than one path. If you specify a path that does not exist, 
NetBackup creates it when restoring the file.

b. Before restoring files that are links, choose whether to update those link 
pathnames:

◆ Select the Rename Hard Links checkbox to rename the hard link pathnames. 
Clear the Rename Hard Links checkbox if you do not want to rename the 
hard link pathname.

◆ Select the Rename Soft Links checkbox to rename the soft link pathnames. 
Clear the Rename Soft Links checkbox if you do not want to rename the soft 
link pathname.

Note If you are restoring system files to a disk other than the current system disk and 
plan on using the other disk as the system disk with the original file paths when the 
restore is completed, we suggest that you select the Rename Hard Links checkbox 
and clear the Rename Soft Links checkbox. This will let you use the other disk and 
have the correct file paths.

c. Confirm or cancel the changes as follows:

◆ Click OK to use the paths indicated in the Restore From box and the Restore 
To box on the next restore.

or

◆ Click Cancel to cancel the changes so the previous paths are used.

3. On the File menu, click Browse backups (restore).

4. Specify the directory to search, the range of dates, the keyword phrase to search for, 
the directory depth, and the filename filter for the files you want to restore.

5. Find and select the files and directories that you want to restore.
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6. Click the appropriate restore command on the Restore menu. 

This opens the xbp_confirm dialog box.

a. Select the Use log file checkbox to create a log file in your home directory and 
write to this file as the operation progresses. 

b. Select the Overwrite existing files checkbox to overwrite an existing file with the 
restored file, providing file permissions allow it (see “File Permissions Required 
By NetBackup” on page 7). The checkbox is selected when highlighted.

Clear the Overwrite existing files checkbox to prevent overwriting. The restore 
does not occur if a file with same pathname already exists.

c. Select the Redirected restore checkbox to confirm the restore to a different path. 
The checkbox is selected when highlighted.

Clear the Redirected restore checkbox to cancel the redirection action.

d. Select the Restore directories without crossing mount points checkbox to skip 
over file systems mounted in the selected directories. The checkbox is selected 
when highlighted.

Clear the Restore directories without crossing mount points checkbox to restore 
file systems that are mounted in the selected directories.

e. Review your selections.

f. Click OK to start to start the restore. The main window displays.

To return to the main window without starting the restore, click Cancel.

Selecting Specific Backup Dates to Restore

By default, the NetBackup Restore window shows the files and folders that were backed 
up since the last full backup. The default range will satisfy the majority of your needs to 
restore files but there will be times when you must restore a file that was not backed up 
during the default time period. For example, a file that was deleted prior to the last full 
backup will not appear in the default display. To search for and restore this file, you must 
change the date range.

If the client belongs to more than one policy, the starting date defaults to the last full 
backup that occurred first. For example, assume that: (1) a client belongs to PolicyW1 and 
PolicyW2, (2) Full backups occur for both of these policies, (3) PolicyW1’s most recent full 
backup occurred on June 16 and PolicyW2’s most recent full backup occurred on June 24. 
NetBackup will display those files and folders that have been backed up since the 
PolicyW1 full backup on June 16.
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If the default display does not show the desired files or directories:

1. Specify the range of backup dates that you believe contains the desired files and 
directories:

◆ Type the desired backup dates in the Range of Dates boxes.

or

◆ Select backups from the Backup Images pane.

The Range of Dates boxes will now contain the oldest and newest backup dates 
in the range of backups that you selected.

Note Narrow the date range as much as possible to speed up your search.

2. Position the pointer over any of the boxes and press Enter (or click Update Display on 
the Edit menu). 

NetBackup updates the Directory Structure pane and the Files pane to show only the 
files and directories that it finds in the range of backups that you specified. You can 
then select the backup you want and restore it.

Since NetBackup has to obtain the file information from the backups on the master 
server, there can be a noticeable delay before the panes appear in the restore window.

Restoring an Earlier Version of a Directory

The following procedure will restore all files that were backed up during the range of 
backup dates that you searched for files to restore. This includes files that were deleted 
from your online directory after they were backed up. If you do not want the deleted files, 
use the procedure described in “Restoring a True Image of a Directory” on page 95.

To restore a version of a directory that existed prior to the last full backup, select only the 
backups that include the desired version of the directory.

For example, assume that you want the /home/hrp/ directory as it existed on 10/5/00.

▼ To restore an earlier version of a directory

1. Browse all dates and examine the Files pane and the Backup Images pane.

In our example, we find that the following backups occurred. 

Backup Date and Time       Type of Backup
10/10/00  22:01:20  . . .  Full Backup  . . .
10/09/00  16:30:27  . . .  Incr Backup  . . .
10/02/00  18:05:41  . . .  Incr Backup  . . .
09/29/00  19:36:55  . . .  Incr Backup  . . .
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09/25/00  18:06:15  . . .  Full Backup  . . .
09/20/00  16:06:21  . . .  Incr Backup  . . .
09/17/00  22:06:44  . . .  Full Backup  . . .

2. Set the start date and end date to include the required backups.

In this example, we set them as follows:

◆ Start date to 09/25/00. This the last full backup preceding 10/5/00. 

◆ End date to 10/02/00. This is the incremental that includes the 10/5/00 version of 
the directory. The next date is 10/09/00, but that has changes we do not want.

3. Start another browse using Update Display from the Edit menu.

4. Select /home/hrp/ from the Directory Structure pane and the check the Files pane to 
see if it shows the files you need.

Note By default, NetBackup restores the directory to its original location. To restore to a 
different path, use Specify Destination Path from the Restore menu before starting 
the restore.

Note If you are selecting directories on the Files pane and then change your mind and 
deselect a directory, it is not deselected until you have selected either Clear 
selections for current directory or Discard selections for previous directories from 
the Edit menu. If you use Inspect all selections from the Edit menu, you can see 
what is selected to be restored.

5. On the Restore menu, click Restore search directory.

Restoring a True Image of a Directory

A true image restore of a directory, by default, restores the directory so its contents are 
exactly what they were at the time of the most recent automatic full or incremental 
backup. Files deleted prior to the specified backup are not restored. 

See “Restoring a True Image of a Directory” on page 40 for an overview of true image 
recovery. The concepts explained there for the Backup, Archive, and Restore interface also 
apply to the menu interface.

True Image Restore and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that 
are currently in the directory but not in the true image restore backups. An example is 
provided in “True Image Restore and Overwriting” on page 41.
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▼ To restore a true image of a directory

Note You can restore a true image of a directory only if the NetBackup policy that is 
backing up your files and directories is configured to collect true image restore 
information. If you are in doubt, ask your NetBackup administrator.

Note NetBackup does not allow a true image restore that is based on the time of a 
user-directed operation. However, NetBackup does use the data from a 
user-directed operation when performing a true image restore if the user backup is 
more recent than the latest automatic full or incremental backup.

Assume you are recovering /home/abc/doc/ as it existed on 12/04/00. Also assume 
you just started the xbp interface, so Browse file system (backup or archive) is selected 
with all settings at the defaults.

1. On the File menu, click Browse backups (true image restore). 

The Directory Structure pane and the Files pane show the directories that are available 
for true image restores. For our example, the default display shows the following.

Directory Structure                 Files
/home/abc

     doc                  12/04/00 20:05:22   doc/
       dirA               12/03/00 21:10:50   doc/
       dirB               12/02/00 20:10:34   doc/
                          12/01/00 20:15:34   doc/ 

Notice that the panes show only directories. Individual files do not appear because 
true image restores are intended only for restoring entire directories. To list or select 
individual files, use the Browse backups (restore) mode. 

Note If NetBackup does not find any directories, check the range of dates, path, and 
directory depth. If these settings are correct and no directories are found, check with 
the administrator on the master server to see if the NetBackup policy that is backing 
up your files and directories is configured to collect true image restore information.

2. Select the desired range of dates.

The default start date is the time of the last scheduled full backup of the policy. Use 
the default unless you are restoring a version that existed before the latest full backup.

The default end date is the current date. If necessary, change this value to reflect the 
date that you want to recover.

In this example, we are recovering the most recent version of the directory so we leave 
the date range at the defaults. 
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◆ Start date is 12/01/00

◆ End date is 12/04/00 

3. If you changed the range of dates in step 2, click Update Display on the Edit menu to 
update the panes.

This step is unnecessary in our example, but is required if you change the range of 
dates.

4. From the Files pane, select the directory that you want to restore. (NetBackup does not 
let you select from the Directory Structure pane for a true image restore.)

In our example, we select the 12/04/00 version of /home/abc/doc/ from the Files 
pane. 

Note If you are selecting directories on the Files pane and then change your mind and 
deselect a directory, it is not deselected until you have selected either Clear 
selections for current directory or Discard selections for previous directories from 
the Edit menu. If you use Inspect all selections from the Edit menu, you can see 
what is selected to be restored.

Note By default, NetBackup restores the directory to its original location. To restore to a 
different location, use Specify Destination Path from the Restore menu before 
starting the restore.

5. On the Restore menu, click Restore selected files and directories. (Restore search 
directory is not available for a true image restore.)

In our example, the restored directory has:

file1
file2
file4

This is the directory as it was at the time of the incremental backup that occurred on 
12/04/00. 

If you are overwriting the directory you are restoring, NetBackup does not delete files 
that are currently in the directory but not in the true image restore backups.
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Resolving Links
When searching for files to restore, you can choose whether to have NetBackup resolve 
links that may exist in the search path. If you resolve links, NetBackup automatically 
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the 
path you type in. For more information, see “Resolving Links” on page 42.

Note xbp resolves links by default, unless you click Do Not Resolve Links in Search 
Directory on the View menu before starting your search.

Note NetBackup does not resolve links if you use wildcard characters in the search 
directory path.

Checking Progress of Operations
When you start a NetBackup operation, you can have NetBackup create a log file in a 
directory of your choice and write to this file during the course of the operation. By 
default, NetBackup creates a log file in your home directory of the form:

bplog.bkup.n (for backups)

bplog.arch.n (for archives)

bplog.rest.n (for restores)

Where n is a number that is unique for each file.
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The following figure illustrates an xbp_progress dialog box.

This dialog box lists the progress log files that are in your home directory and lets you 
view them. (You can also read log files by using the more command or a UNIX file editor.)

The log information is in two scrollable panes:

◆ Log files in your $HOME directory (upper section of dialog)

◆ Contents of selected log file (middle section of dialog)

View the contents of a log by selecting and highlighting its entry in the upper pane. The 
pane in the middle section displays any entries that NetBackup makes in the log file. 

Select the Automatic Refresh checkbox for automatic refresh. You can force a refresh by 
reselecting the same log file. The checkbox is selected when highlighted. 

When you are through checking progress, click Close to return to the xbp_main window.
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Interpreting Progress Logs
The log messages notify you of important events that occur during the operation. These 
messages can have acronyms that specify the error level severity of an event. 

The error level acronyms are as follows:

Progress logs also list the media required for a NetBackup operation. For backups, the 
progress log lists the media IDs as NetBackup requests them during the course of the 
backup. For restores, the progress log begins by listing all the media IDs that NetBackup 
needs to recover the backups containing the files. If a backup or archive is split across 
more than one media ID, a restore log lists all the media but NetBackup uses only what it 
needs to restore the requested files.

Check the status at the end of the log to determine the final results of the NetBackup 
operation. If NetBackup was unable to back up or restore all the requested files, check the 
exit status that appears a few lines before the end of the log. This status will usually reveal 
the cause of the problem.

E-mail Notifications
You can configure a bp.conf file in the client $HOME directory so the user will receive 
e-mail notifications on the results of user-directed operations. For more information, see 
“Configuring E-mail Notifications” in the NetBackup System Administrator’s Guide for 
UNIX, Volume II.

Deleting Progress Log Files
To delete log files from your directory, open the xbp_progress dialog box, select the log 
files and click Delete Log File. You can also delete logs manually by using system 
commands.

Note Before deleting the log files, verify that they do not contain warnings or error 
messages.

INF Informational message (no error occurred)

TRV Trivial error message

WRN Warning error message

ERR Error message

FTL Fatal error message
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Obtaining a List of Your Backups and Archives
You can use the bplist command to get a listing.

The bplist command lists backups and archives according to criteria, such as specific 
file or directory, client name, and range of dates. You can print a list by sending it to a file 
and then printing the file. 

For detailed instructions on using this command, see the bplist man page.

Finding and Selecting Files and Directories
This section explains what you need to know to find and select files and directories. See 
Chapter 5, “Reference Guide to xbp and bp” on page 105 for more information on menus, 
text boxes, and other items mentioned in the following descriptions.

Navigating in the Directory Tree

▼ To go lower in the directory tree

❖ Double click on a lower level directory in the Directory Structure pane.

or 

❖ Click the directory and press Enter.

The Directory to Search box will show the selected directory, and the Directory 
Structure pane and the Files pane are updated accordingly.

or

❖ Type the directory path in the Directory to Search box and press Enter. This has the 
same effect as clicking the directory in the Directory Structure pane.

▼ To go higher in the directory tree

❖ Type the path of the higher level directory in the Directory to Search box and press 
Enter. 

Pressing Enter updates the display (another way to update the display is to click 
Update Display on the Edit menu).
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Show the Contents of a Directory
To see files that are in a directory, click the directory in the Directory Structure pane. The 
contents appear in the Files pane.

Filter by Date
To show only files that were modified or backed up within a certain date range, set the 
Range of Dates boxes to include those dates and press Enter to update the display:

◆ For a backup, specify the last modified dates.

◆ For a restore, specify backup dates.

You could set the range of dates to show only those modified before or after a certain date. 
For example, you could pick only today’s files. 

Filter by File Name
To show only specific file names that are under the Directory to Search box, use the 
Filename Filter box. This makes selection easier if you want only specific files but there 
are many files under Directory to Search box. For example, you can find files ending in 
.doc by using the filter expression *.doc. When xbp starts, the filter is set to * and 
displays everything.

Change the Number of Directory Levels Displayed
To set the number of directory levels displayed, change the number in the Directory Depth 
box (default is 2).

Selecting File or Directory for Backup, Archive, or Restore
To select a file or directory in the Files pane, click its name to highlight it. Clear a file or 
directory by clicking it again:

◆ To select everything in the current directory, click Select all in current directory on 
the Edit menu. Clear an individual file or directory by clicking it again.

◆ To clear all selections for the current directory, click Clear selections for current 
directory on the Edit menu.
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Caution If you click on Select all in current directory on the Edit menu to perform a 
NetBackup operation, and the directory you select is large, the operation can be 
very slow. Instead of selecting everything, consider using Restore search 
directory, Backup search directory or Archive search directory.

During a backup, selecting a directory from the Files pane implicitly selects everything in 
the directory, including subdirectories and files. During a restore, selecting a directory in 
the Files pane restores only the files and subdirectories that are in the backups that 
occurred during the indicated range of dates.

You select from the Directory Structure pane in the same manner as from the Files pane, 
except that you can select only one item at a time. When you select a directory to highlight 
it, the Files pane shows the directories and files in this directory.

When you are through selecting, start the NetBackup operation by choosing the 
appropriate option from the Backup menu or Restore menu. This opens the xbp_confirm 
dialog box and adds your selections to that dialog. If you made previous selections and 
opened the xbp_confirm dialog box but did not confirm your selections (and therefore did 
not perform the actual NetBackup operation), xbp remembers them and keeps them in 
the xbp_confirm dialog box. This lets you return to the main window and make changes 
before confirming.

To clear all selections from the xbp_confirm dialog box, click Discard selections for 
previous directories on the Edit menu. 

Previewing Selected Files
You can view the list of selected files at any time by clicking Inspect all selections on the 
Edit menu. This opens a dialog box similar to xbp_confirm, except that it does not have an 
OK button.

Change Directory Structure Pane and the Files Pane Format
You can change the following aspects of how directories and files appear in the panes.

Show Directory Structure

To indent items in the Directory Structure pane to show the directory hierarchy, click 
Indented tree structure on the View menu. This is the default. To view the full pathnames 
of directories in the Directory Structure pane, click Full Pathnames on the View menu. 
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Show Number of Directory Levels Shown

To modify the number of subdirectory levels that appear in the Directory Structure pane 
and the Files pane, modify the Directory Depth box.

Show Most Recent or All Backups

For a restore, you can choose from the View menu to display either All backup dates for 
each file or Only most recent backup date.

Show File Details

To view file details (for example, file size and write permissions), click Verbose display of 
attributes and filenames on the View menu. To view filenames without details, click 
Brief display of filenames (default).

Update the Display

To update the NetBackup window to show the most recent changes (such as file additions 
or deletions), click Update Display on the Edit menu.
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Reference Guide to xbp and bp 5
This chapter describes the various windows, screens, and menus associated with the xbp 
and bp interfaces. Much of the information in this chapter is also available in the online 
help for the interfaces. Refer to Chapter 4 “Using the X-Windows Interface” on page 75 or 
Chapter 3 “Using the Menu Interface” on page 47 for instructions on using the interfaces. 
For information on the Java interface, refer to Chapter 2 “Using the Backup, Archive, and 
Restore Interface” on page 9 or the online help for that application.
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X-Windows Interface (xbp)
The xbp program provides a graphical interface for NetBackup users. This interface is 
X-Windows based and uses the OSF/Motif conventions. A general description of Motif 
usage is available in the OSF/Motif User's Guide, authored by the Open Software 
Foundation and published by Prentice Hall (ISBN 0-13-640509-6). The following topics 
describe the windows, screens, and menus that you use to perform operations with xbp.

Note The current X-Windows interface does not support AFS restores. This restore can be 
accomplished through the Backup, Archive, and Restore interface.

Special Symbols in Menus and Dialog Boxes
You will encounter the following symbols as you use the menus and dialog boxes:

◆ An ellipsis (...) to the right of a menu item means that when you select the item, a 
dialog box with additional choices appears. If there is no ellipsis in a menu item, the 
operation occurs as soon as you select it.

◆ A diamond shape to the left of a menu item means that two or more mutually 
exclusive modes exist and the mode set by this menu item is currently in effect. For 
example, if you intend to restore an archived file, you want the diamond to the left of 
Browse archives (restore).

◆ An underlined letter in a menu label means a keyboard shortcut. For example, on an 
NCD terminal, pressing ALT in conjunction with a shortcut key opens the associated 
menu. For example, pressing ALT+V opens the <Underline>View menu. Note that 
some terminals may require a key other than ALT. 

◆ Once a menu is opened, a letter (by itself) is sufficient to execute a menu item tagged 
with that letter (pressing i on the <Underline>View menu changes the Directory 
Structure pane format to indented). You can use the up and down arrow keys to move 
the highlight through the various menu items and press Enter to execute the 
highlighted item. The Escape key closes a menu. The left and right arrow keys open 
adjacent menus.

◆ If the pointer is over the main window, its shape changes to a wristwatch shape while 
NetBackup is waiting for an operation to complete. For example, the pointer changes 
to a wristwatch shape when NetBackup is updating its displays and then changes 
back to an arrow when the update is complete.
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xbp Configuration
Borders on windows may vary depending on the window manager used at your site 
(popular examples are twm and mwm). With some window managers, you may have to 
click the left mouse button to position the window if it does not appear in a few seconds. 
You can also use your window manager to resize the window. 

The xbp program has enough space in its text fields to accommodate user-selected fonts 
up to the 10x20 size. The windows can also fit on a 1024x768 screen with some room for 
window manager borders.

There is no default font. If the XNB resource file is in the X search path, xbp uses the 
values set in XNB. On some systems, the default font might be unpleasantly small. On 
other systems, the default font has proportional spacing, causing column misalignment on 
certain fields that have columnar text. 

For an explanation of how to specify X resources to force a particular font, look near the 
end of the Tutorial help files. For example:

1. From the Help menu in the xbp main window, click Tutorial. The Online Help Text 
for xbp dialog box will appear.

2. Scroll to the “Customizing xbp” section. 

If your X server defaults to proportional fonts and you do not know which fonts are 
available for your system, try the generic font name fixed.

Because the default window sizes are small enough to fit on a 1024x768 screen, you may 
find that with larger fonts, the verbose display mode forces you to use a horizontal 
scrollbar to see all the information. Widening the window at runtime with the window 
manager may eliminate the scrollbar. You can also change X resources as described in the 
“Customizing xbp” section of the Tutorial help file to enlarge the default geometry and 
use a smaller font. 

The xbp program depends upon the /usr/lib/X11/XKeysymDB file to correctly use 
editing keystrokes such as backspace and delete. The NetBackup installation procedures 
are designed to install a nominal version of this file if it does not already exist. An existing 
version of the file is not overwritten, thereby ensuring that user-customized versions of 
XKeysymDB are not destroyed.

Sun systems typically have a version of XKeysymDB that does not define some editing 
keys. Either you or the administrator must compare your current XKeysymDB file to the 
NetBackup standard version /usr/openv/netbackup/bin/XKeysymDB on 
NetBackup server machines. Then do one of the following:

◆ Append the NetBackup version onto the existing one.

◆ Replace the existing one with the NetBackup version.

◆ Edit the existing version to achieve your preferred keyboard support.
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xbp Window
The xbp window opens when you start the X-Windows interface.

You can open menus from the menu bar to start backup, archive, and restore operations. 
The text boxes let you enter specific values for finding and selecting directories and files. 
The lists show information about selected directories and files.
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Directory to Search Box

Specifying the directory to search is the starting point when browsing for files to back up, 
archive, or restore. The default is the directory you used to start the X-Windows interface. 
You can change the directory to search by typing a new directory path in the Directory to 
Search box and pressing Enter, or by double clicking on a directory in the Directory 
Structure pane.

When specifying the directory to search, you can also use the following wildcard 
characters

* ? [ ] 

For example:

/home/s* 
/home/.??* 
/home/[a-z]*
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If you are backing up or restoring a file path that has a wildcard character used literally 
(that is, as a non-wildcard character), you must escape the wildcard using a backslash (\) 
character. For example, the following path uses brackets that are not being used as 
wildcards:

/home/abc/fun[ny]name

To back up or restore this file path, you must precede the brackets with backslashes as in

/home/abc/fun\[ny\]name

so NetBackup interprets the brackets literally.

The backslash acts as an escape character only when it precedes a wildcard as in the above 
example. This means that NetBackup normally interprets it literally and it is a legal 
character to use in pathnames.

The Directory to Search box automatically scrolls horizontally to allow entry of long 
pathnames. To view paths that do not fit in the window, a scroll bar allows you to scroll 
horizontally.
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Range of Dates Boxes

The Range of Dates boxes allow you to specify a date range for browsing and selecting 
files. The left box is the start date and the right box is the end date. 

◆ For a restore, enter the range of dates that includes the times when you suspect the 
desired backups or archives occurred.

◆ For a backup or archive, enter the range of dates that includes the times when the 
desired files were last modified.

The Directory Structure pane and the Files pane will show only those files that meet the 
date range criteria. The administrator can change the initial browse default to show a 
smaller range of dates by using the INITIAL_BROWSE_SEARCH_LIMIT option in the 
server and client /usr/openv/netbackup/bp.conf files.



X-Windows Interface (xbp)

112 NetBackup User’s Guide for UNIX

Browse Mode

When you start the X-Windows interface, it is in backup mode and the default date range 
is from 01/01/70 to the current date. You can change this range by typing new values 
with the keyboard and pressing Enter. In the United States, the format for:

◆ dates is month/day/year

01/23/93

◆ time is hours:minutes:seconds. Hours are expressed in terms of the 24 hour clock. 

12 am is 00:00:00

12 pm is 12:00:00

11:30 pm is 23:30:00. 

Leave the end date blank to search from the start date to the current date.

Restore Mode

When you switch from backup mode to restore mode, NetBackup normally changes the 
starting date so that it defaults to the most recent full backup. However, if you type a 
specific date just before changing modes, your specification is used.

If the client belongs to more than one policy, the start date defaults to the last full backup 
that occurred first. For example, assume that the client belongs to PolicyW1 and PolicyW2 
and full backups occur for both of them. If the last full backup for PolicyW1 occurred 
before the one for PolicyW2, then the display shows files ranging from the time of the 
PolicyW1 full backup.
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Keyword phrase to search for Box

Enter a keyword phrase that NetBackup will associate with the backup being created by a 
backup or archive operation. You can then restore the backup by specifying the keyword 
phrase.

You can use this option in place of or in combination with the other restore options in 
order to make it easier to restore your backups and archives. The following meta 
characters can be used to simplify the task of matching keywords or parts of keywords in 
the phrase:

* matches any string of characters.

? matches any single character.

[ ] matches one of the sequence of characters specified within the brackets.

[ - ] matches one of the range of characters separated by the “-”.
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The keyword phrase is a textual description of the backup that is a maximum of 128 
characters in length. All printable characters are permitted including space (“ “) and 
period (“.”). You must enclose the phrase in double quotes (“...”) or single quotes ( ‘...’) to 
avoid conflict with the UNIX shell.

The default keyword phrase is the null (empty) string.

Backup Images Pane

The Backup Images pane opens within the main window when you execute Browse 
backups (restore), Browse backups (true image restore), or Browse archives (restore) 
from the File menu. This pane shows the backups or archives for your client. You can 
search either all or some of the backups to find directories and files that meet the values in 
the Directory to Search box, the Range of Dates boxes, the Directory Depth box, 
Filename Filter box, and the Keyword phrase to search for box.
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The list starts with the most recent backup or archive. The list contains the following 
information on each backup:

The rules for selecting backups from the Backup Images pane are:

◆ Selecting a specific backup changes both dates to show the backed up time for the 
selected backup.

◆ Selecting a range of consecutive backups changes the date boxes to show the oldest 
and newest times in the selected range.

◆ Selecting another backup cancels previous selections. If the list is longer than the 
window, a vertical scroll bar appears along the right edge. 

When you are satisfied with your selections, move the pointer over one of the text boxes 
and press Enter. This updates the Directory Structure pane and the Files pane to show the 
directories and files that are in the selected backups and that match the entries made in the 
Directory to Search box, the Range of Dates boxes, the Directory Depth box, Filename 
Filter box, and the Keyword phrase to search for box. 

Note There may be a noticeable delay before the update occurs because the client must 
obtain this information from the NetBackup master server.

Backed Up Date and time at which the backup occurred.

Expires Date and time at which NetBackup expires the backup and removes it from 
the Backup Images pane.

Files Number of files in the backup.

KB Size of the backup in kilobytes.

Sched Type Shows the type of schedule as follows:

- Full Backup

- Incr Backup

- User Backup

- User Archive

Policy Backup policy that created the backup. The system administrator configures 
the policy names, as explained in the NetBackup System Administrator’s Guide, 
Volume I. 

Keyword Shows the keyword entered by the user when the backup was initiated.
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Directory Depth Box

The Directory Depth box determines how deep to search the subdirectories of the current 
directory. It has no effect on the Files pane. Increment or decrement the depth by typing a 
new value with the keyboard and pressing Enter. The default is 2.
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Filename Filter Box

The Filename Filter box determines the files of a selected directory that NetBackup shows 
in the Files pane. When you start the X-Windows interface, the Filename Filter box has a 
value of * and the Files pane shows all files. You can change the filter to limit the files that 
NetBackup shows. In addition to specific file names, you can use the following types of 
expressions to filter filenames:

◆ Asterisk (*) matches one or more characters. For example, a search for *_log 
matches all files that end with _log.

◆ Question mark (?) matches a single character. For example, a search for log? 
matches the log1, log2, and log3 files.

◆ Brackets ([]) specify any of the listed characters. For example, a search for 
prog[1-4] finds all five-character files that start with prog and end with a digit 
in the range 1 through 4. 
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Directory Structure Pane and the Files Pane

These panes show the directories and files that you can select for NetBackup operations. 
Directories in the Files pane are followed by a slash. The contents of these panes depends 
on the browse mode.

For more information on browsing directory trees and selecting files, see “Finding and 
Selecting Files and Directories” on page 101.

Browse file system (backup or archive) Mode

If you are in Browse file system (backup or archive) mode, the panes show the directories 
and files in the filesystem that:

◆ Are in the Directory to Search box or in subdirectories below it in the client's 
directory tree (the Directory Depth box determines number of levels shown).

◆ Have modified dates within the time frame specified in the Range of Dates boxes.
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◆ Are in the currently selected directory which match the value in the Filename Filter 
box. 

When you start the X-Windows interface, it is in the Browse file system (backup or 
archive) mode and shows all directories and files that reside under the directory from 
which you executed the xbp command.

Browse backups (restore) or Browse archives (restore) Mode

If you are in Browse backups (restore) or Browse archives (restore) mode, the panes 
show the directories and files that are in the selected backups or archives and meet the 
following criteria:

◆ Are in the Directory to Search box or in subdirectories below it in the client's 
directory tree (the Directory Depth box determines number of levels shown).

◆ Were backed up within the time frame specified by the Range of Dates boxes. 

◆ Are in the currently selected directory which matches the value in the Filename Filter 
box.

Browse backups (true image restore) Mode

If you are in Browse backups (true image restore) mode, the panes show the directories 
that are in the selected backups and meet the following criteria:

◆ Are in the Directory to Search box or in subdirectories below it in the client's 
directory tree (the Directory Depth box determines number of levels shown).

◆ Were backed up by a scheduled full or incremental backup within the time frame 
specified by the Range of Dates boxes. 

◆ Are in the currently selected directory which matches the value in the Filename Filter 
box. 

Browse for Scripts Modes

When in the Browse for Scripts modes, the panes show the same type of information as 
when you browse the file system for backups or archives.

NetBackup offers database extensions that you can use, in conjunction with xbp, to back 
up and restore many of the most popular databases. These NetBackup for database 
extensions are separately priced products which must be installed and configured to work 
with xbp. See the system administrator’s guide for the specific database for details.

Browse backups (restore raw partitions) Mode

When in the Browse backups (restore raw partitions) mode, the panes show the same 
type of information as when you browse the file system for backups or archives.



X-Windows Interface (xbp)

120 NetBackup User’s Guide for UNIX

Browse backups (Auspex FastBackup raw partition)  Mode

Note Auspex FastBackup is not supported in NetBackup 5.0.

Menus (xbp)
The menus in the xbp window enable you to start backup, archive, and restore operations.

File Menu

The File menu has commands for finding and selecting files for NetBackup operations. 
You can also browse for and select database scripts.

Browse file system 
(backup or archive)

Causes NetBackup to update its Directory Structure pane and the Files pane 
with directories and files that meet the criteria entered in the Directory to 
Search box, the Range of Dates boxes, the Filename Filter box, and the 
Keyword phrase to search for box.

Browse backups 
(restore)

Causes NetBackup to build a list of the backups that exist for this client. The 
completed list appears in a Backup Images pane that opens in the main 
window. 
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Edit Menu

The Edit menu has commands to modify your selections.

Browse backups 
(true image restore)

Causes NetBackup to build a list of the true image backups that exist for this 
client. The completed list appears in a Backup Images pane that opens in the 
main window. 

Browse archives 
(restore)

Causes NetBackup to build a list of the archives that exist for this client. The 
completed list appears in a Backup Images pane that opens in the main 
window. 

Browse backups 
(restore raw 
partitions)

Causes NetBackup to build a list of the raw partition backups that exist for 
this client. The completed list appears in a Backup Images pane that opens in 
the main window. 

Browse backups 
(Auspex 
FastBackup raw 
partition) 

Auspex FastBackup is not supported in NetBackup 5.0.

Browse file system 
for database 
extension

NetBackup offers database extensions that you can use, in conjunction with 
xbp, to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed, then configured to work with xbp. See the system 
administrator’s guide for the database extension for details.

The Browse File System commands enable the NetBackup for database 
extension. They cause NetBackup to update its Directory Structure pane and 
the Files pane to show all directories and files that meet the criteria of the 
Directory to Search box, the Range of Dates boxes, Filename Filter box, and 
the Keyword phrase to search for box.

Configuration Opens the xbp_config dialog box from which you can specify the master 
server, the client to browse for restores, the client to restore to, and the policy 
type of images to browse. For more information, see “xbp_config Dialog Box” 
on page 127.

Quit Terminates the X-Windows interface.
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Clear selections for 
current directory

Clears file selections from the Files pane. You must use Discard selections for 
previous directories to clear the xbp_confirm dialog box.

Select all in current 
directory

Selects all the files in the Files pane.

Discard selections 
for previous 
directories

Clears file selections from the xbp_confirm dialog box.

Inspect all 
selections

Opens the xbp_viewselect dialog box, which shows you the files that are 
currently selected. This dialog box has only information and no commands 
except to close the dialog box or to obtain help.

Update Display Rereads your directory tree and updates the Directory Structure pane and the 
Files pane. This is equivalent to pressing Enter in any of the text boxes.
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View Menu

The View menu has commands that modify how NetBackup shows directory and file 
information in the Directory Structure pane and the Files pane.

Brief display of 
filenames

Shows filenames without details. The display starts in brief mode.

Verbose display of 
attributes and 
filenames

Shows file details such as size and file permissions.

Indented tree 
structure

Indents items in the Directory Structure pane to show the hierarchy of the 
directory tree. You can use either Indented tree structure or Full Pathnames 
mode, but not both. The default is indented mode.

Full Pathnames Shows full pathnames in the Directory Structure pane. You can use either Full 
Pathnames or Indented tree structure mode (see above), but not both. The 
X-Windows interface starts in the indented mode.

All backup dates 
for each file

Shows all backups for each file in the Files pane. You can execute this 
command only when the File menu is set to one of the browse backups mode 
or archives modes (diamond shape to the left of those entries). The choice is 
unavailable when you browse the file system. The All backup dates for each 
file and Only most recent backup date choices are mutually exclusive. You 
can use either but not both. The X-Windows interface starts in the All backup 
dates for each file mode.

Only most recent 
backup date

Shows only the most recent backup of a file in the Files pane. This command 
is useful if you lose a directory and want to get the most recent copy of all files 
(which may be spread across many backups). You can execute this command 
only when the File menu is set to one of the browse backups mode or archives 
modes (diamond shape to the left of those entries). The choice is unavailable 
when you are browsing the file system. The All backup dates for each file 
and Only most recent backup date choices are mutually exclusive. You can 
use either but not both. The X-Windows interface starts in the All backup 
dates for each file mode.



X-Windows Interface (xbp)

124 NetBackup User’s Guide for UNIX

Backup Menu

The Backup menu has commands to start a backup or archive of selected files and 
directories. You can also obtain a progress report on backups or archives. The File menu 
must be set to a browse file system mode (diamond shape to the left of the command) 
before you can execute any Backup menu commands, other than the report on progress. If 
the X-Windows interface is in a restore mode, when you pull down the Backup menu, the 
backup commands are unavailable.

Note If you click Backup selected files and directories or Archive selected files and 
directories but then close the xbp_confirm dialog box without confirming your 
selections, you are returned to the main window. Your file selections, however, 
remain in the xbp_confirm dialog box. This feature is useful if you want to return to 
the main window to edit your selections. To clear previous file selections, click 
Discard selections for previous directories on the Edit menu.

Resolve Links in 
Search Directory

If you click this command, NetBackup automatically changes any links in 
your search path so the path points to the actual file or directory. This is the 
default.

Do Not Resolve 
Links in Search 
Directory

If you click this command, NetBackup searches for the path as you type it in, 
without resolving links.

Backup selected files 
and directories

Starts a backup of the current selections from the Files pane by opening the 
xbp_confirm dialog box. This dialog box shows the current selections. Click 
OK to execute the backup. Click Cancel to abort and return to the main 
window.

Backup search 
directory

Starts a backup of the current selection from the Directory Structure pane by 
opening the xbp_confirm dialog box. This dialog box shows the current 
selection. Click OK to execute the backup. Click Cancel to abort and return 
to the main window.
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Restore Menu

The Restore menu has commands to start a restore of selected files and directories. You 
can also obtain a progress report on restores. The File menu must be set to a Browse mode 
(diamond shape to the left of the command) before you can execute any Restore menu 
commands, other than the report on progress. Otherwise, when you pull down the 
Restore menu, those choices are unavailable.

Backup database 
using selected 
scripts

NetBackup offers database extensions that you can use, in conjunction with 
xbp, to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed, then configured to work with xbp. See the system 
administrator’s guide for the database extension for details.

This command starts a backup of a database by opening the xbp_confirm 
dialog box. This dialog box shows the scripts you selected from the Files 
pane. Click OK to execute the backup. Click Cancel to abort and return to 
the main window.

Archive selected 
files and directories

Starts an archive of the current selections from the Files pane by opening the 
xbp_confirm dialog box. This dialog box shows the current selections. Click 
OK to execute the backup. Click Cancel to abort and return to the main 
window.

Archive search 
directory

Starts an archive of the current selection from the Directory Structure pane 
by opening the xbp_confirm dialog box. This dialog box shows the current 
selection. Click OK to execute the backup. Click Cancel to abort and return 
to the main window.

Report progress of 
backup

Opens the xbp_progress dialog box, which shows the log files pertaining to 
your backup operations. See “xbp_progress Dialog Box” on page 132 for 
more information.

Report progress of 
archive

Opens the xbp_progress dialog box, which shows the log files pertaining to 
your archive operations. See “xbp_progress Dialog Box” on page 132 for 
more information.
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Note If you click Restore selected files and directories but then close the xbp_confirm 
dialog box without confirming your selections, you are returned to the main 
window. Your file selections remain in the xbp_confirm dialog box. This feature is 
useful if you want to return to the main window to edit your selections. To clear 
those previous file selections, click Discard selections for previous directories on 
the Edit menu.

Help Menu

The Help menu has online instructions for using the X-Windows interface.

Specify 
Destination Path

Opens the xbp_destpath dialog box. This dialog box lets you redirect the 
restore to a directory other than the one from which they were backed up. If 
you specify a path that does not exist, NetBackup creates it when restoring the 
file.

Restore selected 
files and 
directories

In all browse modes except true image restore, this command starts a restore 
of current selections in the Files pane. In true image restore mode, this 
command starts a true image restore of the selected directory. In both cases 
the xbp_confirm dialog box opens to show the current selections. Click OK to 
execute the backup. Click Cancel to abort and return to the main window.

Restore search 
directory

This command starts a restore of the current selection in the Directory 
Structure pane by opening the xbp_confirm dialog box. This dialog box shows 
the current selections. Click OK to execute the backup. Click Cancel to abort 
and return to the main window.

This command is not available in Browse backups (true image restore) mode.

Restore database 
using selected 
scripts

These commands start a restore of their respective type of database by 
opening the xbp_confirm dialog box. This dialog box shows the scripts you 
selected from the Files pane. Click OK to execute the backup. Click Cancel to 
abort and return to the main window.

NetBackup offers database extensions that you can use, in conjunction with 
xbp, to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed and configured to work with xbp. See the NetBackup 
system administrator’s guide for the specific database extension for details.

Report progress of 
restore

Opens the xbp_progress dialog box, which shows the log files pertaining to 
your restore operations. See “xbp_progress Dialog Box” on page 132 for more 
information.
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Dialog Boxes (xbp)
The dialog boxes are used to specify information to perform backups, archives, or 
restores.

xbp_config Dialog Box

The xbp_config dialog box opens when you click <Underline>Configuration on the File 
menu. 

The xbp_config dialog box lets users change the following values. After completing your 
changes:

◆ Click OK to use the new values.

or

◆ Click Cancel to cancel the changes so the previous values are still used.

Server This is the current master server to which NetBackup sends backup and 
archive requests and also the server that has the backup you can browse for 
files to restore to your client. The master server is the first line listed under the 
SERVER option in the /usr/openv/netbackup/bp.conf file on the client. 
See the NetBackup System Administrator’s Guide for UNIX, Volume I for more 
information on the bp.conf file.

When you start the X-Windows interface, this box shows the default master 
server configured for your client. You can change the name of the master 
server. If you specify an invalid name or your client does not belong to a 
configured policy on that server, you get an error message.
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Client to browse 
for restores

Client whose backed up files you can currently browse. The administrator on 
the master server can change this name to that of another client and can grant 
you permission to do the same by making the necessary changes to the 
/usr/openv/netbackup/altnames file on the master server. 

When you start the X-Windows interface, this box shows the name of the 
client on which you are running as specified by the CLIENT_NAME parameter 
in the /usr/openv/netbackup/bp.conf file on the client. 

See the NetBackup System Administrator’s Guide for UNIX, Volume I for more 
information on the altnames file and the bp.conf file.

Client to restore to When you start the X-Windows interface, this field shows the name of the 
client on which you are running.

The administrator running the X-Windows interface on the master server can 
change this name in order to direct files to another client. This ability is not 
available to other users.

Policy type of 
images to browse

Type of client to which you are restoring files when you redirect a restore to a 
different client.

The client type must match that in Client to restore to box and the Client to 
browse for restores box. You cannot restore clients from one type to another.
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xbp_destpath Dialog Box

The xbp_destpath dialog box opens when you click Specify Destination Path on the 
Restore menu. This dialog box lets you set up a restore to a path other than the one from 
which files were originally backed up.

The text boxes at the top of the dialog box show the restore paths:

When you start the X-Windows interface, these paths are set to your current directory to 
search.

Use the mouse and keyboard to change the paths in the Restore From box and the Restore 
To box. You can click the Current Directory button to change the values in both boxes to 
their default, which is your current directory to search. If you specify a path that does not 
currently exist, NetBackup creates it when restoring the file. 

After completing your changes to the paths:

◆ Click OK to use the Restore From and Restore To paths on the next restore.

or

◆ Click Cancel to cancel the changes so the previous paths are still used.

You can also rename soft (symbolic) and hard links to the files so those links show the 
Restore To pathname:

Restore From Full or partial pathname that NetBackup uses to find the files to 
restore.

Restore To The path to which you want NetBackup to restore the selected 
files.

Rename Hard Links Select to rename hard links so they point to the new path. The button is 
enabled when highlighted.

Rename Soft Links Select to rename soft (symbolic) links so they point to the new path. The 
button is enabled when highlighted.
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xbp_confirm Dialog Box

The xbp_confirm dialog box opens when you execute a NetBackup operation. This dialog 
box shows the items you picked in the Directory Structure pane or Files pane and lets you 
confirm them before continuing. If the list of selections is longer than the dialog box, a 
vertical scroll bar appears along the right edge.

Use log file The Use log file checkbox lets you select whether you want NetBackup to 
create a progress log file in your home directory and write to this file as the 
operation progresses.

Enable the Use log file checkbox to use the log file (this is the default). The 
name of the log file appears in the Log Filename box. Use report progress 
commands from the Backup menu or the Restore menu to read these files. 
(See “xbp_progress Dialog Box” on page 132 for more information.)

Log Filename When the Use log file checkbox is selected, the default log file name displays 
in the Log Filename box. Use report progress commands from the Backup 
menu or the Restore menu to read these files. (See “xbp_progress Dialog Box” 
on page 132 for more information.)

Overwrite existing 
files

If you are restoring files or directories, the Overwrite existing files checkbox 
lets you choose whether you want to overwrite existing files. 

Select the Overwrite existing files checkbox to overwrite. See “File 
Permissions Required By NetBackup” on page 7 for an explanation of how file 
ownership and permissions affect overwriting of files and directories.

Clear the Overwrite existing files checkbox if you do not want to overwrite 
existing files. The restore will not occur if the file exists.
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Note Mount points inside will get restored whether or not the Restore directories 
without crossing mount points box is selected.

When you are satisfied with your selections, click OK to start the NetBackup operation. 

To cancel and return to the main window without performing a NetBackup operation, 
click Cancel. The cancel does not affect your selections. After canceling, you can either 
edit your selections or clear them by clicking Discard selections for previous directories 
on the Edit menu.

Redirected restore If you previously changed the destination path, the Redirected restore 
checkbox is active and lets you restore files into a directory other than the one 
from which they were backed up (see “xbp_destpath Dialog Box” on 
page 129). If you did not change the destination path, the checkbox is 
unavailable.

Select the Redirected restore checkbox to restore the files to the alternate 
directory.

Clear the Redirected restore checkbox to cancel the redirected restore to a 
different path. 

Restore directories 
without crossing 
mount points

To skip over file systems mounted in the selected directories, select the 
Restore directories without crossing mount points checkbox. This option is 
selected by default). 



X-Windows Interface (xbp)

132 NetBackup User’s Guide for UNIX

xbp_progress Dialog Box

The xbp_progress dialog box opens when you execute a Report progress of backup, 
Report progress of archive, or Report progress of restore from the appropriate menu. 
This dialog box shows the related progress log files in your home directory and lets you 
view them in order to monitor the progress of the operation. 

See “Checking Progress of Operations” on page 98 for information on using this dialog 
box.
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Menu Interface (bp)
The bp program is a menu-driven user interface to NetBackup. When using the menus, 
execute an operation by typing the letter to the left the related menu item. For example, 
typing b from the main menu takes you to the Backup Menu (it is usually unnecessary to 
press Enter). An ellipsis (...) to the right of an option means that when you choose the 
option, another menu or screen appears from which you can make further choices. If there 
is no ellipsis, the operation occurs immediately.

Main Menu
The menu items in the Main Menu enable you to open the Backup or Restore menu.

Master Server Master server to which NetBackup sends operation requests. Use the m 
(Change Master Server) option from the Backup Menu or the Restore Menu to 
specify another master server.

Client Displays the name of the client for which the backup or archive will be 
performed.

b (Backup) Opens the Backup Menu.

r (Restore) Opens the Restore Menu.

h (Help) Help information for the Main Menu. Each secondary menu also has this 
option.

q (Quit) Terminates the program and returns to the shell prompt.
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Backup Menu
The menu items in the Backup Menu enable you to begin a backup operation.
 

Master Server This is the master server to which NetBackup sends backup and restore 
requests. You can use the m (Change Master Server) option to specify another 
master server.

Client Displays the name for the client for which the backup or archive will be 
performed.

b (Backup Files 
and Directories)

Opens the Backup of Files and Directories menu.

a (Archive Files 
and Directories)

Opens the Archive of Files and Directories menu.

Backup database 
options

NetBackup offers database extensions that you can use, in conjunction with 
bp to back up and restore many of the most popular databases. These 
NetBackup for database extensions are separately priced products which 
must be installed. See the system administrator’s guide for the specific 
database for details.

o (Backup Oracle 
DB)

Opens the Backup Oracle DB menu.

i (Backup 
Informix DB)

Opens the Backup Informix DB menu.

s (Backup Sybase 
DB)

Opens the Backup Sybase DB menu.
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Backup of Files and Directories Menu
The menu items in the Backup of Files and Directories menu enable you to search for a 
specific backup and to begin a back up operation.

p (Backup SAP 
DB)

Opens the Backup SAP DB menu.

2 (Backup DB2 
DB)

Opens the Backup DB2 DB menu.

t (Backup 
SQL-BackTrack 
DB)

Opens the Backup SQL-BackTrack DB menu.

m (Change Master 
Server)

Lets you change the master server to which NetBackup sends backup and 
restore requests. If it is an invalid server or the client does not belong to a 
user-directed backup policy on that server, you receive an error message. The 
master server is set to the configured default for your client each time you 
start the menu interface.

h (Help) Help information for the Backup Menu. Each secondary menu also has a Help 
option.

q (Quit Menu) Closes the Backup Menu and returns to the Main Menu.

Search Path This is the starting point for searches that you start with the s (Select Files and 
Directories) option. You can change the current directory with the p (Change 
Search Path) option from the menu.
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Start Date The Start Date and End Date show the range of dates that the search will 
include. Start Date is the earliest modified date and time that a file can have for 
NetBackup to be included in the search. You can change the Start Date with 
the d (Change Date Range) option from the menu. When you start the menu 
interface, the Start Date is set to 01/01/70 00:00:00 for backups and archives.

End Date The Start Date and End Date show the range of dates that the search will 
include. End Date is the latest modified date and time that a file can have for 
NetBackup to be included in the search. You can change the End Date with the 
d (Change Date Range) option from the menu. When you start the menu 
interface, the End Date is set to 23:59:59 of the current day.

Master Server This is the master server to which NetBackup sends NetBackup operation 
requests. You can use the m (Change Master Server) option to specify another 
master server.

Display Mode Displays the display mode, either verbose or brief. Refer to “x” on page 137 
for more details.

Files Selected Number of files currently selected for backup. This number changes as you 
select or deselect files with the s (Select Files and Directories) option or e 
(Edit/View Selected Files) option.

Keyword Phrase Displays the keyword phrase entered for the backup.

s (Select Files and 
Directories)

Displays the list of files and directories for the indicated path. Select files 
and/or directories from this list to back up.

e (Edit/View 
Selected Files) 

Displays the list of files and directories previously selected for backup. You 
can also add or delete selections from the list. For more information, see 
“Edit/View Selections Screen” on page 150.

i (Initiate Backup) Starts the backup operation. Prompts for creating a log file in your home 
directory and writing to this file as the operation proceed are displayed.

p (Change Search 
Path)

Changes the directory at which subsequent search operations begin.

d (Change Date 
Range)

Changes the Start Date and End Date as shown at the top of the menu. These 
dates specify the range in which a file's modification date must be in order to be 
included in the search for files to back up. Entering this option displays 
prompts for typing new start and end dates. 

Some basic rules for typing dates are as follows:

The format for dates is month/day/year. For example, 01/23/93.

The format for time is hours:minutes:seconds and in terms of the 24-hour clock. 
For example, 12 am is 00:00:00, 12 pm is 12:00:00, and 11:30 pm is 23:30:00.

To leave a date unchanged, press Enter at the prompt.

If you change only part of the date or time and press Enter, NetBackup 
completes the entry.
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m (Change Master 
Server)

Changes the master server to which NetBackup sends backup and restore 
requests. If an invalid server is selectede, or the client does not belong to a 
user-directed backup policy on that server, you will receive an error message. 
The master server is set to the configured default for your client each time you 
start the menu interface.

k (Change 
Keyword 
Phrase)

Changes the keyword phrase entered for the backup.

x (Change Display 
Mode to 
Verbose)

Selects whether the Search screen shows only names or also includes file 
details such as permissions. Toggle the Display Mode indication to Verbose for 
file details and to Brief to deselect them.

h (Help) Help information for the Backup of Files and Directories menu. Each 
secondary menu also has a Help option.

q (Quit) Closes the Backup of Files and Directories menu and returns to the Main 
Menu.
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Archive of Files and Directories Menu
The Archive of Files and Directories menu has choices for archive operations. Archive and 
backup operations are the same except that an archive deletes the file after backing it up, 
thus freeing disk space. 

The information at the top of the menu, as well as the menu choices, are the same as the 
Backup of Files and Directories menu. The one exception is the i (Initiate Archive) option, 
which starts the archive operation.



Chapter 5, Reference Guide to xbp and bp

Menu Interface (bp)

139

Database Backup Menus
The database backup menus have choices for their respective types of database backups. 
The following figure is an example of the Backup Oracle DB menu.

The information at the top of the menu, as well as the menu choices, are the same as the 
Backup of Files and Directories menu. The one exception is the i (Initiate Oracle DB 
Backup Using Selected Script(s)) option. Choosing this option uses the scripts you 
selected with the s (Select Scripts) option and e (Edit/View Selected Scripts) option to 
back up Oracle databases. The other Backup DB menus are the same, except for the menu 
choice that starts the backup. 

Refer to the system administrator’s guide for the specific database for more information.
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Restore Menu
The menu items in the Restore Menu enable you to select the type of restore you want to 
perform.
 

Note Auspex FastBack is not supported in NetBackup 5.0. 

Master Server This is the master server that has the backup for the files you are 
browsing. You can use the m (Change Master Server) option to select 
another master server.

Client Client that backed up the files you are permitted to browse and restore.

b (Restore Files and 
Directories from 
Backups)

Opens the Restore Backups menu.

a (Restore Files and 
Directories from 
Backups)

Opens the Restore Archives menu.

r (Restore From Raw 
Partition Backups)

Opens the Restore Raw Partition Backups menu.

f (Restore From 
Auspex FastBack 
Backups)

Auspex FastBack is not supported in NetBackup 5.0.

d (Restore From True 
Image Backups)

Opens the Restore True Image Backups menu.
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Restore database 
options

NetBackup offers database extensions that you can use, in conjunction 
with bp, to back up and restore many of the most popular databases. 
These NetBackup for database extensions are separately priced products 
which must be installed. See the system administrator’s guide for the 
specific database for details.

o (Restore From 
Oracle DB Backups)

Opens the Restore Oracle DB menu.

i (Restore From 
Informix DB 
Backups)

Opens the Restore Informix DB menu.

s (Restore From 
Sybase DB Backups)

Opens the Restore Sybase DB menu.

t (Restore From 
SQL-BackTrack DB 
Backups)

Opens the Restore DB using SQL-BackTrack menu.

p (Restore From SAP 
DB Backups)

Opens the Restore SAP DB menu.

2 (Restore From DB2 
DB Backups)

Opens the Restore DB2 DB menu.

m (Change Master 
Server)

Allows you to change the master server to which NetBackup sends 
backup and restore requests. If it is an invalid server or the client does not 
belong to a user-directed backup policy on that server, you receive an 
error message. The master server is set to the configured default for your 
client each time you start the menu interface.

h (Help) Help information for the Restore Menu.

q (Quit Menu) Closes the Restore Menu and returns to the Main Menu.
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Restore Backups Menu
The menu items in the Restore Backups menu enable you to select a backup for restore 
and to begin the restore process.

Search Path This is the starting point for searches that you start by choosing the s (Select 
Files and Directories). You can change the current directory with the p 
(Change Search Path) option from the menu.

Start Date Start Date and End Date show the range of backup dates NetBackup searches 
for files to restore. Start Date is the earliest backup date and time that 
NetBackup checks when searching backups. You can change this with the d 
(Change Date Range) option from the menu.

End Date The Start Date and End Date show the range of backup dates that NetBackup 
searches for files to restore. End Date is the latest modified date and time that 
a file can have for NetBackup to be included in the search. You can change this 
with the d (Change Date Range) option from the menu.

Files Selected Number of files currently selected. This number changes as you select or 
deselect files with the s (Select Files and Directories) or e (Edit/View Selected 
Files) option.

Directory Depth This number indicates how many levels of directories and files NetBackup 
shows on the Search screen. You can increment or decrement the depth with 
the c (Change Directory Depth) option. The default is 1.

Display Mode Displays the display mode, either verbose or brief. Refer to “x” on page 137 
for more details.

Master Server Master server that has the backup for the files you are browsing. You can use 
the m (Change Master Server) option to select another master server.
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Source Client Client that backed up the files you are permitted to browse and restore. You 
can use the b (Change Source Client) option to select another client.

Destination Client Client to which NetBackup will restore the selected files. This option will be 
displayed when you log in as root. Only the administrator on the master 
server can change this name to that of another client. See the t (Change 
Destination Client) option for information on changing this name.

Policy Type Your client type. See the y (Change Policy Type) option for information on 
changing the policy type.

Keyword Phrase Displays the keyword phrase entered for the backup.

s (Select Files and 
Directories)

Takes you to the Search screen from which you can browse the backup. From 
this screen, you can select files and directories to restore.

e (Edit/View 
Selected Files)

Shows the list of files and directories previously selected for restore. You can 
also add or delete selections from the list.

i (Initiate Restore) Brings up the Initiate Restore screen from which you can start the operation. 
Prompts for specifying the following display:

◆ NetBackup creates a log file in your home directory and writes to this file 
as the operation proceeds. 

◆ existing files that have the same names as those you are restoring should 
be overwritten.

If you selected a (Change Destination Path), you will be prompted to verify 
that you want to:

◆ restore to an alternative path

◆ rename hard links

◆ rename soft links

x (Change Display 
Mode to 
Verbose)

Selects whether the Search screen shows only names (Brief mode) or also 
includes file details such as permissions (Verbose mode). Toggle the Display 
Mode indication to Verbose to select file details and Brief to deselect them.

l (List Backup 
Images)

Lists the backups for the client that meet the entries in the Search Path, Start 
Date, End Date, Directory Depth, and the Keyword Phrase fields.

q (Quit) Closes the Restore Backups menu and returns to the Main Menu.

h (Help) Help information for the Restore Backups menu. 

p (Change Search 
Path)

Changes the directory at which subsequent search operations begin. To find a 
specific file, type its complete pathname at the prompt. You can also use 
wildcard characters *, ?, [, and ] to find multiple files and directories. 

d (Change Date 
Range)

Changes the Start Date and End Date at the top of the menu. These dates 
specify the range of backup dates that NetBackup searches during a restore. 
Entering this option displays prompts for typing new start and end dates.
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c Change 
Directory Depth)

Changes the number of levels of directories and files that appear on the 
Search screen. The new number appears in the Directory Depth field at the 
top of the screen. The default depth is 1.

m (Change Master 
Server)

Specifies the master server with the backup for the files you want to restore. If 
it is an invalid server or the client does not belong to a user-directed backup 
policy on that server, you receive an error message. The master server is set to 
the configured default for your client each time you start the menu interface.

b (Change Source 
Client)

Lets the administrator on the master server browse and restore files for 
another client. The administrator can also change the configuration to give 
this ability to other users. When you start the menu interface this name is set 
to the default (normally the client on which you are running).

t (Change 
Destination 
Client)

Lets the administrator on the master server direct restored files to another 
client. When you start the menu interface, this name is set to the default 
(normally the client on which you are running).

a (Change 
Destination 
Path)

Restores files to a directory other than the one from which they were backed 
up. If you specify a path that does not currently exist, NetBackup creates it 
when restoring the file.

y (Change Policy 
Type)

Note Lets the administrator on a server direct client restores. The policy type 
must match that specified in the Source Client and Destination Client 
fields. You cannot restore files from one client type to another.

k (Change 
Keyword 
Phrase)

Change or enter the keyword phrase for your search.
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Restore Archives Menu
The Restore Archives menu is the same as the Restore Backups menu, except that the 
restore of archived files and directories can be initiated.

Restore Raw Partition Backups Menu
The following figure shows the Restore Raw Partition Backups menu. You use the choices 
on this menu to select and initiate restores of raw partition backups. See “Restore Backups 
Menu” on page 142 for an explanation of the menu items.
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Restore True Image Backups Menu
The following figure shows the Restore True Image Backups menu. The menu options can 
be used to select and initiate restores of true image backups. See “Restore Backups Menu” 
on page 142 for an explanation of the menu items.

Restore Database Menus
The Restore Menus for databases have choices for restoring their respective database 
backups. The following figure is an example of the Restore Oracle DB menu.
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The information at the top of the menu and the menu options have the same meaning as 
the corresponding lines and options on the Restore Backups menu. The one exception is 
the i (Initiate...) option which starts the restore operation for the selected database. 

When you choose the i (Initiate Oracle DB Backup Using Selected Script(s)) option, 
NetBackup uses the scripts you selected with the s (Select Scripts) option and the e 
(Edit/View Selected Scripts) option to restore Oracle databases. The other Restore DB 
menus are the same, except for the menu choice that starts the restore.

Refer to the system administrator’s guide for the specific database for more information. 

Common Screens
The content of these screens varies depending on whether you are doing a backup, 
archive, or restore.

Backup or Archive Search Screen

During a backup or archive, the Search screen appears when you choose the s (Select Files 
and Directories) option from the archive or backup menu. Use this screen to select 
directories and files for archive or backup.

Selections Number of files or directories previously selected. This number changes as 
you select or deselect files.
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Restore Search Screen

During restores, the Search screen appears when you choose the s (Select Files and 
Directories) option and NetBackup has completed its search for files and directories. Use 
this screen to select files and directories to restore.

The information fields on the top line have the same meanings as the Backup or Archive 
Search screen. The list shows the contents of the current directory at the time that the 
backup or archive occurred. 

◆ For a restore archive, the list contains files and directories from user-directed archives. 

◆ For a restore backup, the list contains files and directories from user-directed and 
administrator scheduled backups.

◆ For a true image restore, the list contains only the directories from scheduled full and 
incremental backups. Files do not appear, nor do the results of user-directed backups 
or archives.

Current Path Current directory. This is the directory where currently displayed files and 
directories reside and is the highest level directory that you can currently 
show on the screen. Use Zoom(I)n or(Z)oomOut to move up or down in the 
directory tree from the current directory.

File List The file list shows directories and files that are in the current directory. The 
options at the bottom of the screen let you browse the directory tree and to 
make selections (see “Search Screen Options” on page 149). 

Q  (not shown on screen) Type Q to exit without making any changes.
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Type Q (not shown on screen) to exit without making any changes.

Search Screen Options

The options at the bottom of the Search screen let you browse the directory tree and make 
selections. Remember that it usually takes longer to search the backups than the file 
system (as is done during a backup or archive).

Execute an option by typing the letter in parentheses. For example, Z moves you up to the 
parent of the current directory. Type Q (not shown on screen) to exit without making 
changes. You can use either upper or lower case letters.

Zoom(I)n Moves you down one level in the tree to show the files and directories that are 
in the directory to which the arrow symbol currently points.

(Z)oomOut Moves you up one level in the tree to show the files and directories that are in 
the parent of the current directory.

(S)elect Selects the directory or file indicated by the current position of the pointer and 
adds an asterisk * to the left of the line. Pressing S again clears the item.

(B)ack Shows the previous screen of information.

(F)wd Shows the next screen of information.

(U)p Moves the pointer up one item in the list.

(D)n Moves the pointer down one item in the list.

(L)eft Shifts the display to the left, if you had previously shifted it to the right in 
order to show lines that are too wide for the screen.

(R)ight Shifts the display to the right in order to show lines that are too wide for the 
screen.

(O)k Retains your current selections and returns to the previous menu.
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Edit/View Selections Screen

The Edit/View Selections screen appears when you choose the e (Edit/View Selected 
Files) option from a Backup, Archive, or Restore (other than true image) menu. This screen 
shows the directories and files that you have selected for backup, archive, or restore 
(depending on the operation you are performing). 

Note This screen is called View/Delete for true image backups and restores and lets you 
delete, but not add, selections.

The top line on the screen shows the number of total selections. This number changes as 
you select or deselect files.
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The options at the bottom of the screen let you alter your selections. Select an option by 
typing the letter in parentheses. You can use either upper or lower case letters. For 
example, B shows the previous screen. Type Q (not shown on screen) to exit without 
making any changes.

View/Delete Selections Screen

The View/Delete Selections screen appears when you choose e (View/Delete Selected 
Files) from the Restore True Image Backups menu. This screen shows the directories you 
have selected for the true image restore.

(A)dd Selection This option does not appear on the View/Delete screen for true image 
restores. Lets you add a selection to the list. Choosing this option shows a 
dialog box in which you type the pathname of the file or directory you are 
adding. Pressing Enter adds the new selection to the list. 

If you add a selection for a restore, bp uses the range of dates determined by 
the current values of Start Date and End Date when searching for files. This 
provides some added versatility when searching for backups. For example, if 
you want to add a file that is outside the date range used for existing 
selections, you can exit to the restore screen, change the date range, then 
return to the Edit/View Selections screen and add the extra file.

You can also use wildcard characters *, ?, [, and ] to specify multiple files and 
directories.

Un(S)elect Unselects the directory or file to which the arrow symbol currently points and 
deletes it from the list.

(C)lear Clears all previous selections.

(B)ack Shows the previous screen of information.

(F)wd Shows the next screen of information.

(U)p Moves the pointer up one item in the list.

(D)n Moves the pointer down one item in the list.

(L)eft Shifts display to the left, if you had previously shifted it to the right in order to 
show lines that are too wide for the screen.

(R)ight Shifts the display to the right in order to show lines that are too wide for the 
screen.

(O)k Retains your current selections and returns you to the previous menu.
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System Administrators A
This section contains additional information on the Backup, Archive, and Restore 
interface for the NetBackup Administrator.

Redirecting Restores to Different Clients
There are two types of redirected restores: those that can be performed by the user, and 
those that can be performed by the system administrator.

User-Directed

Users can restore files to their client that were backed up by another client. The 
NetBackup Master server must be configured to allow a redirected restore to a different 
client, and the user must have authorization to perform the restore.

Server-Directed

Any administrator on any NetBackup server can direct a restore to the client that backed 
up the files. The administrator can also perform a redirected restore to a different 
client—that is, files backed up from one NetBackup client can be restored to another 
NetBackup client of the same type. Server-directed restores can be useful, for example, if 
users do not have permission to restore the files themselves.

Files or raw partitions can be restored to any client of the same type that backed up the 
files. It is not possible to perform a server-directed restore through a database-extension 
product such as NetBackup for Oracle.
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Policy Type Settings

When redirecting to a different client, the destination client must be of the same policy 
type as the source client. Refer to the following table:

Restore Path Formats

When redirecting a restore to a different client, you must use the appropriate path format 
for the source and destination. Refer to the following table:

Redirecting a Restore from a Backup Exec Image

When redirecting a restore from a Backup Exec image, the redirection path format is the 
same as for NetBackup image restores. NetBackup does not support restoring Backup 
Exec Netware non-SMS backups created using the Netware redirector.

Redirecting a Restore to a Different Client

To redirect a restore to a different client, use the following procedure.

Policy Types for Clients

Client Policy

UNIX Standard

Microsoft Windows NT, 2000, 
XP, Server 2003

MS-Windows-NT

NetWare Target Standard

NetWare Non-Target NetWare

Restore Path Formats

Client Path Format Example

UNIX /directory/ /usr/openv/netbackup/

Microsoft Windows drive:\directory\ C:\VERITAS\NetBackup\

NetWare NonTarget /drive/directory/ /C/VERITAS/NetBackup/

NetWare Target /target/volume/data_path /MARGE/SYS/veritas/netbackup/
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▼ To redirect a restore to a different client

The following are general instructions for performing a server-directed restore to a client.

1. Log on as root to the UNIX master server that backed up the files.

2. Start the Backup, Archive, and Restore interface.

3. Click the Restore Files tab.

4. From the Actions menu, choose Specify NetBackup Machines and Policy Types.

5. Click on the NetBackup server tab.

6. Select the NetBackup master server that backed up the files and click Make Current. 
This gives you access to the image catalog on that system so you can browse the 
desired backups.

7. Click on the Source client/Policy type tab.

a. Select the client that originally backed up the files and click Make Current. This 
allows browsing and restoring files backed up from that client.

b. Select the policy type for the images that you are going to browse. Refer to the 
table “Policy Types for Clients” on page 154.

Note The Source and Destination client must always be of the same type.

Note The Destination Client tab is enabled only if the user is root or a non-root 
administrator and the machine jbpSA is connected to is a server. jbpSA determines 
this by checking the name of the machine jbpSA is connected to against the server 
list.

8. Click on the Destination Client tab.

9. If the client to which you want to redirect the restore is not listed in the Client List 
window, enter that client in the New Client Name field and then click Add.

10. In the Client List window, select the client to which to redirect the files then click 
Make Current.
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The following example screen shows a restore of files that were backed up to hagar 
(NetBackup server) from windows (source client) and are now being restored to a 
client named folip (destination client). Both clients are standard.

11. On the Actions menu, point to Select Restore Type and choose the desired restore 
type, or select a type from the Restore Type list box.

12. To refresh the list of items available for restore, click Refresh on the View menu.

13. Select the files or folders you want to restore.

Note The Browse directory box is unavailable when browsing Windows, Lotus Notes, or 
MS Exchange clients.

14. Click Restore.

The Restore Files dialog box appears.

15. Select the desired Destination to which to restore the files.

For more information on redirecting restores to different paths, see “Redirecting Files 
to a Different Path” on page 36.
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The paths in the Source and Destination boxes must use the formats required by the 
clients as shown in the table “Restore Path Formats” on page 154.

16. Select the desired restore options.

17. To begin the restore, click Start Restore.

Preventing Server-Directed Restores
To prevent server-directed restores, either add or delete settings on the client as shown in 
the following table:

Restoring AFS Backups
This section notes the differences in the interface that the user will encounter when 
restoring backups from an AFS client.

All restores must be performed by the administrator either on the NetBackup for AFS 
client or the master server. The administrator can use the Backup, Archive, and Restore 
interface on the master server to restore volumes to the same or to redirect the restore to a 
different NetBackup for AFS client (AFS file server).

Restores are performed on the basis of volumes. To restore a vice partition, the 
administrator must select all the volumes in that partition.

Settings to Prevent Server-Directed Restores

Client Type Location of Setting To Prevent Server- 
Directed Restores

Microsoft Windows General tab in NetBackup Client Properties dialog box on 
the client (click NetBackup Client Properties on the Files 
menu to display this dialog box)

Clear Allow server 
directed restores box

UNIX /usr/openv/netbackup/bin/bp.conf Add 
DISALLOW_SERVER_ 
FILE_WRITES

NetWare 
(Target and Non-Target)

General tab in NetBackup Configuration dialog box on the 
client (click Configure on the Actions menu to display this 
dialog box)

Clear Allow server 
directed restores box
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Browsing and Marking Volumes/Vice Partitions
When browsing for AFS backups, you cannot use the Browse directory field to enter a 
specific path. Instead, select the vice partition you wish to view in the Directory Structure 
pane and its contents will be displayed in the right pane. 

Note The full path is not displayed in the Directory Structure pane. For example, 
/vicepa/user.abc is displayed instead of /AFS/eagle/vicepa/user.abc.

Restoring to Different Volumes/Vice Partitions
The Backup, Archive, and Restore interface provides a convenient mechanism for 
specifying a different name for a volume and/or vice partition. Specifying a different 
volume name prevents an existing volume from being overwritten by the restore.

◆ If you do not specify Overwrite existing files or a different name for the volume, then 
NetBackup adds an “R” to the name of the restored volume as follows:

◆ If the volume name is less than 22 characters long, NetBackup adds a leading “R” 
to the name of the restored volume. For example:

If the volume name is: /vicepa/user.abc

The restored name is: /vicepa/Ruser.abc

◆ If the volume name is 22 characters long (maximum allowable length for a 
volume name), the first character of the original volume name is replaced with an 
R. For example:

If the volume name is: /vicepa/engineering.documents1

The restored name is: /vicepa/Rngineering.documents1

◆ If you are redirecting the restore to a different path and specify an existing volume, 
you must select the Overwrite existing files option for the restore to succeed. In this 
case, the entire volume is overwritten. If you do not select the Overwrite existing 
files option, the restore will fail.

◆ When redirecting a restore of a volume to a different vice partition, the vice partition 
must exist or the restore will fail.

Restoring Raw Partitions
A raw partition restore will restore a bit-by-bit backup of a partition of a disk drive on 
UNIX (on Windows this is called a restore of a disk-image backup). You can restore a 
NetBackup raw partition backup or a FlashBackup raw partition backup. To restore a raw 
partition, you must have administrator capabilities on the master server or client. 
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For more information about FlashBackup, see the NetBackup Advanced Client System 
Administrator’s Guide. 

Notes on Raw Partitions and Disk Images
◆ Ensure that the partition is not mounted and not in use (if the partition is being used 

by a database, make sure to shut down the database). The partition must be the same 
size as when it was backed up. Otherwise, the results of the restore are unpredictable.

◆ Ensure that the device file for the raw partition exists prior to the restore.

◆ The overwrite option is ignored during raw partition restores (except for Windows 
disk image restores). The device file must exist and the disk partition is overwritten 
whether this option is set or not.

◆ If you performed a raw partition backup of a disk partition used for file systems, you 
must restore the entire partition to recover a single file. To avoid overwriting the 
entire partition, redirect the restore to a different path, restoring the raw partition to 
another raw partition of the same size, and then copy individual files to the original 
file system.

▼ To restore an entire UNIX raw partition

Note An entire raw partition can only be restored from a full backup. (NetBackup does 
not distinguish between full and incremental backups when performing a standard 
raw partition backup.)

1. Log on as root to the UNIX master server that backed up the files.

2. Start the Backup, Archive, and Restore interface.

3. Click on the Restore Files tab.

4. Select the Policy type, as follows:. 

a. From the Actions menu, choose Specify NetBackup Machines and Policy Types.

b. Click the Source client/Policy type tab.

c. Select the Policy type. For a NetBackup raw partition restore, select Standard; for 
a FlashBackup raw partition restore on a UNIX client, select Flashbackup.

d. Click OK.
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5. From the Actions menu, point to Select Restore Type and choose Raw Partition 
Backups.

6. In the Browse directory box specify the directory path to the device file, for example, 
/dev/rdsk/.

7. Click the Refresh button to refresh the list of raw partition backups available for 
restore.

8. In the right pane, select the device file.

9. To begin the restore operation, click Restore.

▼ To restore individual directories or files on a UNIX client

Note To restore individual directories or files from a raw partition backup, the client must 
be in a FlashBackup policy.

1. Log on as root to the UNIX master server that backed up the files.

2. Start the Backup, Archive, and Restore interface.

3. Click on the Restore Files tab.

4. Select the Policy type. 

a. From the Actions menu, choose Specify NetBackup Machines and Policy Types.

b. Click the Source client/Policy type tab.

c. If you are restoring individual directories or files on a UNIX client, select 
Flashbackup.

d. Click OK.

5. On the Actions menu, point to Select Restore Type and choose Normal Backups.

6. In the Browse directory specify the directory path to the device file.

7. Click the Refresh button to refresh the list of raw partition backups available for 
restore.

8. In the right pane, select the desired files or folders.
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9. To begin the restore operation, click Restore.

Previewing Required Media
The Preview option allows you view a list of the media IDs that are required to restore the 
selected files and directories. This feature is only available if your client is also a 
NetBackup server and if you have administrator privileges. 

1. Click the Restore Files tab.

2. Select the files and folders that you want to restore.

3. Click Preview.

4. To begin the restore operation, click Restore.
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